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1 HelpMatics™ overview

1.1 Introduction

HelpMatics™ is a service management system for the IT Helpdesk and other service departments.
This tool helps companies to efficiently organize incident and problem management and the
associated support workflow.

In addition to ticket processing, HelpMatics™ offers many other functions such as documentation,
information management and online reporting. Further features are its multi-client capability and the
support of QM processes by an integrated knowledge management.

The special advantage of HelpMatics™ s its intuitive handling in any workflow, ergonomic front-ends,
equal structure in all modules, comparatively easy implementation and administration, optimal
transparency and continuous traceability in the support.

Our main objective during development was and is to combine maximum functionality with minimum
operating effort. Many advantages will only manifest themselves during the daily work with
HelpMatics™, which is confirmed again and again by our customers.

This documentation will acquaint you step by step with the use of HelpMatics™.

We hope that you will work efficiently with HelpMatics™.

1.2 Prerequisites

We guarantee you minimum implementation time. If you are already using HCL Domino/Notes as
application in your company, you’ll have the optimal prerequisites for immediate implementation of
HelpMatics™. No additional licenses, no expensive extension of a Notes infrastructure, no additional
server hardware are necessary. We take your existing groupware platform as basis and within a short
time you will have an adequate service management system.

The implementation of HelpMatics™ is easy. If you are not using HCL Notes yet, we can supply you
with a pre-tailored system (incl. server hardware on request) at a reasonable price.

It is also possible to use an Internet browser as HelpMaticsTM client.
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1.3 HelpMatics™ standard and SMB version

HelpMatics™ is available in a standard version and in an SMB version with limited features.
The limitations of the SMB version are described in a separate document.

1.4 Using HelpMatics™ Enterprise

HelpMatics™ has been designed for global support of several sites and distributed teams.
This permits a differentiation in the replication of tickets, configurations and their effective control over
various areas of support.

The standard version making use of the Enterprise setup is recommended for decentralized support at
companies with several sites.

Instructions applying only to the use of the Enterprise features are highlighted in this manual as
follows:

— —
ENTERPRISE:
— —

1.5 HelpMatics™ CMS Enterprise

HelpMatics™ CMS Enterprise, a Configuration Management System of the HelpMatics™ Suite, uses
a relational database management system (RDBMS)+ for data storage.

The features that are exclusively available in HelpMatics™ CMS Enterprise are marked as follows:

HELPMATICS™ CMS ENTERPRISE:
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1.6 Modules

This manual deals with the administration of the following modules, which can also be used
separately:

= ServiceDesk (incl. HelpMatics™ Widgets)

= Knowledge

= Change

= Configuration Management (also refer to the separate HelpMatics™ CMS manual)
The following databases are important for the administration as well:

= Portal: Configuration of the web portals.

= Transfer: Control of company-wide data transmission between the modules in the Enterprise
Setup.

= Admin: Recording of administrative data used by all modules.

You'll find information applying to all modules in chapter 6. Examples referring to a specific module are
marked by parentheses around the module - e.g. (ServiceDesk). In the subsequent chapters, module-
specific information is dealt with.

In the administration of HelpMatics™ ServiceDesk and HelpMatics™ Knowledge, the data and/or
documents of both modules are displayed in views, categorized according to the respective module. In
the administration of HelpMatics™ Change, only the administrative data available for the Change
module is displayed. If you want to administrate the data of all modules at the same time, open the
Admin module.
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2 Installation

2.1 Client system requirements

- HCL Notes client 8.5.2 to 9.0, on all supported operating systems (MS Windows, Apple
Macintosh)
or: Web Browser (recommended: IE/Chrome/Firefox)
or: MS Terminal Server client

- network connection to HCL Domino Server

2.2 Server system requirements

= HCL Domino server 8.5.3 FP2 with UpgradePack 1 to 9.0
= Every operating system supported by HCL Domino as server operating system
| I

ENTERPRISE:

The CorpYTODATABASE_NEW_UNID=1 parameter in the Notes.INI file of all servers concerned is a
prerequisite for correct data exchange between distributed sites.

How to proceed:
There are various options for installing HelpMatics™. One of them is described in the following:

2.3 Installation

1. Copy the templates to the local Notes data directory and remove the write protection from the
files.

2. Create new replica of the templates stored on the server in the Notes client (appropriate rights
provided).

3. Sign the templates with an ID authorizing you to run agents without restrictions.

4. Create new databases using the templates stored on the server.
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3 Accessrights

3.1 Rights required for the installation

3.1.1 Access rights to the individual databases
Via the access control list (accessible via File > Database > Access) you regulate the access rights to
HelpMatics™ databases. For this you require database access as Manager.

In the following chapters, the access rights settings for HelpMatics™ ServiceDesk, Knowledge Base,
HelpMatics™ Change and Configuration Management are described.

Details of the additional databases Admin, Portal and Transfer are described at the end of chapter 3.

3.1.2 Clients

If you want to use HelpMatics™ with several clients, make the following settings in the access control
list (ACL):

Client access: If you want to grant individual groups/persons access to data (e.g. users and tickets) of
a specific client only, add these groups/persons to the ACL and assign only the role of the desired
client and not the roles of the other clients.

Clients are created via the HelpMatics™ Administration, see chapter 4. In this process, the
corresponding roles (company abbreviation) are automatically created in the ACL and are assigned to
all persons/groups by default.

In the example given, a HM_1st-Level COC group was created in the Domino directory (NAB), added
to the ACL, and rights restricted to the COC AG client were granted.

Access Control List to: HM9 ServiceDesk B |
'{l Basics Access Control List Attributes |
% Roles People, Servers, Groups | Show All w| Usertype |Person group v
E:'g i -Default- Access Manager ]

a M) toccess HM
i s
G;Q Py ' Administratoren Create document
vanced anonymous Delete documents
“ HelpMatics_1st-Level ¥| Creats private agents
“ HelpMatics_2nd-Level | Create personal folders/views
| Crete shaed fodersviews
' LocalDomainAdming | Create LotusScript/Java agents
Dﬂ LocalDomain Servers +'| Read public documents
[ OtherDomainServers «| Write public documents

Replicate or copy documents

Roles 7 [AF_READALL] ~
v| [&F_REOPEN]
| [&F_REPORTIM
Add... Rename... Remove [&R_1STLEVEL]
Effective Access... | [&R_ZNDLEVEL
[AR_ZMNDLEVEL
Full name: HelpMatics_Admin 7 [4R_MANAGER
An Access Control List {(ACL) defines who can view and edit your Notes [V [&R_PROBLEMC( v
database. Select a name in the list to see or set the access assigned to the < >
name.
Last change: domino& on 15.10.2013 14:28:17
According to: coc-ag OK Cancel

Fig. 1: Access control list (ACL)
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This means that a member of the HM_1st-Level COC group can only see and edit users and tickets of
the COC AG client (ServiceDesk module). This group cannot access data of another client.

In case of a configuration with more than one client, several clients can, however, be assigned to one
group.

3.2 HelpMatics™ ServiceDesk rights

3.2.1 Grant access rights — Create Notes groups

At least 3 groups should be created in the Domino directory (NAB) (the descriptions may vary; further
groups may be defined, e.g. HelpMatics_2nd-LevelCreate):
a. HelpMatics_Admin:
HelpMatics™ administrators (HelpMatics™ managers): members of this group can make
configuration settings in HelpMatics™.
b. HelpMatics_1st-Level:
1st level team members that can create, edit and forward tickets.

C. HelpMatics_2"d-Level:

2nd [evel team members that can edit and forward tickets. These team members cannot create
new tickets.

It may be necessary to create a forth group.
HelpMatics_2"-Level-Create:

2nd level team members that can create new tickets and edit them as well as edit and forward
tickets assigned to them.
This group is assigned the 2nd-LevelCreate role instead of the 2nd-Level role.
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3.2.2 Define access rights

The groups created have to be entered into the access control list (ACL) with the following rights:

a. HelpMatics_Admin:

User type: Person Group
Access: Manager or Editor not authorized to define new clients
Target group: HelpMatics™ managers
Access Control List to: HM3 ServiceDesk H R
—_— : : |
—'{I Basics Access Control List Aftributes
% o People, Servers, Groups | Show All v | Usertype |Person group v
Eg o _Default- Access Manager W
= x:;;';:m | Create documents
<5 Advanced Delete documents
anonymous
#) HelpMatics_1st-Level +|Create private agents
# HelpMatics_2Znd-Level | Create personal folders/views
|Crate shared fldrsviews
# LocalDomainAdmins | Create LotusScript/Java agents
EE. L°CE'|D°“13?”SEW9F5 +| Read public documents
[ ctherDomain Servers | Write public documents
Replicate or copy documents
Roles [ [BF_READALL]
[/] [&F_REOFEN]
[/] [&F_REPQRTIN
| Add... I | Fename... | | Remove | [] [8R_1STLEVEL]
| Effective Access... | [] [8R_ZNDLEVEL
! i [[] [8R_2NDLEVEL
e 17 [ER_MANAGER
(T AR _PROELEME
An Access Control List (ACL) defines who can view and edit your Motes [/] [BR_PROBLEMC v
database. Select a name in the list to see or set the access assigned to the < >
name.
Last change: domino6 on 15.10.2013 14:28:17 oK I | Cancel
According to: coc-ag

Fig. 2: ACL with Admin rights
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b. HelpMatics 1st-Level

User type:
Access:

Target group:

Person Group
Editor

Holp-Maki<s

Helpdesk / servicedesk team members

Access Control List to: HM9 ServiceDesk

_'gJBasi
%Hola
(¥ Log

2k Advanced

Access Control List

People, Servers, Groups |Show Al

-Default-
W) Access HM
W) Administratoren
anorymous

' HelpMatics_1st-Level

#) HelpMatics_2nd-Level
#) HelpMatics_Admin
#) LocalDomainAdmins
[AA LocalDomainServers
[AA otherDomainServers

A ||

Bename...

Remove

| Effective Access... |

Full name: HelpMatics_1st-Level

An Access Control List (ACL) defines who can view and edit your Motes
database. Select a name in the list to see or set the access assigned to the < >

name.

Last change: domino6 on 15.10.2013 14:28:17
According to: coc-ag

HIE,

Altributes

Lserpe

| Create documents

[] Delete documents

[ Create private agents

Create personal folders Aviews
[[] Create shared folders/views
[]Create LotusScript/Java agents
+| Read public documents

| Write public documents
Replicate or copy documents

Access

Roles [V] [&F_READALL] ~

[] [8F_REQPEN]

] [8F_REPORTIN:
¥ [8R_15TLEVEL]
] [8R_2NDLEVEL
] [8R_2NDLEVEL
] [8R_MANAGER.
[ [8R_PROBLEME
] [8R_PROBLEM: v

ok || cancel

Fig. 3: ACL with 1st level rights
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c. HelpMatics 2nd-Level

User type: Person Group
Access: Editor
Target group: Members of 2nd/3rd level support (not authorized to create tickets)

EE)

Access Control List to: HM9 ServiceDesk

,g_gj Basics Access Control List Attributes
9 Roles People. Servers, Groups | Show Al Usertype | Person group v
o Log -Defautt- Access | Author v
#) Access HM
o5 Advanced #) Admiristratoren [[ICreate documents
anonymous [] Delete documents
[ Create private agents

#) HelpMatics_1st-Level

#) HelpMatics_Admin

#) LocalDomainAdmins
[0 LocalDomainServers
[0 OtherDomainServers

' HelpMatics_2nd-Level

Add... |_| Rename...

Remave

Effective Access... I

Full name: HelpMatics_2nd-Level

An Access Control List (ACL) defines who can view and edit your Notes

[ Create personal foldersAviews
Create shared folders/views

[ Create LotusScript/Java agents

+| Read public documents

[w] White public documents

Replicate or copy documents

Roles [V] [AF_READALL] ~
[] [F_REOFEN]

[] [F_REPORTIN
[] [AR_1STLEVEL]
[¥] [AR_2NDLEVEL
[] [AR_2NDLEVEL
[] [AR_MANAGER
[] [AR_PROBLEME
[] [AR_PROBLEM( v

database. Select 3 name in the list to see or set the access assigned to the L4 >

name.

Last change: dominob on 15.10.2013 142817
According to: coc-ag

oKk || cancsl

Fig. 4: ACL with 2nd level rights
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d. HelpMatics 2nd-LevelCreate

User type: Person Group
Access: Editor
Target group: Members of 2nd/3rd level support (authorized to create tickets)
Access Control List to: HM3 ServiceDesk E E
—'{I Basics Access Control List Attributes
W People, Servers, Groups | Show Al v | Usertype |Person group v
Eﬁ L -Default- Access Editor ]
= x::;tl-lmtru::ren | Create documents
ol Advanced anomymous [] Delete documents
# HelpMatics_1st Level [ Create private agents
" HelpMatics_2nd-Level Create Create personal folders /views
#) HelpMatics_Admin [ Create shared folders/views
#} LocalDomainAdmins []Create LotusScript/Java agents
JHE) L"CE”D"”"E?”SE“’E"S /| Read public documents
[ OtherDomainServers | Write public documents
Replicate or copy documents
Roles [/ [aF_GLOBAL]  ~
[] [&F_GLOBALADN
[] [&F_QUICKDELE
| Add... || Bename.. ||  FRemove | [+/] [6F_READALL]
| Effective Access.. | [] [&F_REQPEN]
) [] [&F_REPORTINC
Full name: HelpMatics_2nd-Level Create [] [8R_1STLEVEL]
[] [&R_ZNDLEVEL]
An Access Control List (ACL) defines wha can view and edit your Notes [+/] [BR_2ZNDLEVEL! v
database. Select a name in the list to see or set the access assigned to the < >
name.
Last change: domino6 on 15.10.2013 14:28:17 | oK I | Cancel I
According to: coc-ag

Fig. 5: ACL with extended 2nd level rights

e. "Default" entry
After adaptation of the ACL, the Default entry will be deprived of database access:

User type: Not specified
Access: No access
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3.2.3 Roles

By default, the following roles are available. These roles have to be assigned to the relevant persons /
groups (via File > Database > Access). Furthermore, the availability of the ServiceDesk module has to
be activated in the process editor document (see chapter 4.9) .

Role

Description

[&R_MANAGER]

By default, these roles are only assigned to the HelpMatics Admin group
since they permit access to all administrative settings (Administration
menu).

[&F_REPORTING]

Usually, this role is also reserved for the HelpMatics Admin, but can also
be assigned to any group or person. Access to Reporting is associated
with this role.

[&R_1STLEVEL]

A role meant for 1st level helpdesk or servicedesk members (assignment
to HelpMatics 15™-Level group).

[&R_2NDLEVEL]

This role grants 2" level team members the rights required for ticket
processing.

These rights are the basis for editing tickets taken over or being
assigned for processing. It is, however, not possible for the 2nd level
team members to change priority or responsibility or set the status to
closed.

[&R_2NDLEVELNEW]

Unlike staff with second level role, team members with this role can
create tickets themselves. In these tickets (i.e. where they are the
responsible persons) they can prioritize, change responsibility and set
the status to closed.

[&F_REOPEN]

Closed tickets cannot be easily reprocessed. The owner of this role can
reset closed tickets to work in progress. Recommended for HelpMatics™
managers and higher, possibly also for helpdesk/servicedesk members.

[<XXX>]

For each client (e.g. company) that has been created in HelpMatics™ a
role is created using the company abbreviation (e.g. [COC] and [FIR] in
the figure).

[&F_DELTICKETS]

This role allows deleting tickets. This also requires the deletion rights in
Notes.

[&F_QUICKDELETE]

Optional role for managers. Please note: When deleting main
documents, the respective reply documents will not be considered.

[&F_READALL]

Optional role. Allows access to all documents and eliminates the
restriction to clients.

[&F_GLOBAL]

Only available in the Enterprise environment with several databases.
To be assigned to all team members.

[&F_GLOBALADMIN]

Only available in the Enterprise environment with several databases.
For HelpMatics™ managers having the right to define global categories.

[&R_PROBLEMOWNER]

For creating and editing problem tickets

[&R_PROBLEMEDIT]

For editing problem tickets. Does not include creating new problem
tickets, closing problem tickets or changing priorities in problem tickets.

COC AG
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Roles with the prefix &R have a hierarchical structure, i.e. lower level rights are included in higher
levels:

Level 4: [&R_MANAGER] [&R_MANAGER]

Level 3: [&R_1STLEVEL] [&R_PROBLEMOWNER]
Level 2: [&R_2NDLEVELNEW] [&R_PROBLEMEDIT]
Level 1: [&R_2NDLEVEL]

3.2.4 HelpMatics™ ServiceDesk — distributed sites (Enterprise)

There are two different HelpMatics™ configurations: One for the local user helpdesks of the different
sites, the other for the central user helpdesk (database type to be set under Administration - Modules
in the Enterprise tab).

The installation procedure required for using the HelpMatics™ Enterprise transfer mechanism
between several HelpMatics™ databases is described in the following (applies to Enterprise
environment only):

ENTERPRISE:

To extend your HelpMatics system by an additional site database, proceed as follows (connection of a
local helpdesk site):

1. HelpMatics™

Create new databases on the local user helpdesk server using the HelpMatics ServiceDesk and
HelpMatics Admin templates.

Make the requested settings under Administration > Modules. (There is only one central database, but

2R

re-a

e.g. Sweden and enter a company abbreviation, e.g. SE

In this way the role [SE] will be automatically created in the ACL (SE representing the company
abbreviation; here: Sweden).

Assign this role ([SE]) to all persons, groups and servers that are to have access to the documents of
this client.

Make the necessary configuration settings (see paragraph 4).

2. Knowledge base

a. Create a new database on the local user helpdesk server using the HelpMatics
Knowledge template.

b. Create a new client in the database viastgAdministration > Clients,

c. Assign this role [SE] to all persons, groups and servers that are to have access to the
documents of this client.
d. Make the requested settings via Administration > Modules.

e. Make the necessary configuration settings (see paragraph 8).

3. Further modules

a. Create new databases on the local user helpdesk server on the basis of the
corresponding templates.

b. Make the requested settings via Administration > Modules and complete the access
control list.
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4, Transfer

a. Create a new replica of HelpMatics Transfer on the local user helpdesk server.

b. Create a configuration document for the local database via the Configuration — New >
Local database menu.

3.3 HelpMatics™ Knowledge rights

3.3.1 Access rights

All helpdesk team members require at least the Editor access level with the Create personal folders

and views option.

By means of roles you specify if documents are visible, can be created or edited. The following roles

can be assigned:

Role

Description

[&R_KBMANAGER]

Knowledge Manager: Can edit all knowledge documents for which he/she
has the client role or that are free to all clients

The Delete documents option should only be active for users having the
manager role.

[&R_EXPERT]

Expert:
Can edit knowledge documents assigned to him/her (also see 8.1)

[&R_MANAGER]

Administrator:
Can edit experts, expert groups, categories ... and the configuration.

[&R_CREATOR]

Creator of documents: Can create new FAQ and solution documents.
These are integrated into the editorial workflow.

[&F_REPORTING]

Access to Reporting is associated with this role.

[ <xyz>]

Freely definable user roles, such as [ _User], [_Support] for which
knowledge documents can be released for reading, start with an
underscore.

In order to make FAQ documents available to all persons via a portal, the
Anonymous entry with Author access level and the desired user and client
roles is added to the ACL.

Please note: When editorial workflow is activated, Default must be set to No
Access. If all employees are to get reading rights via the Notes client, a
corresponding group must be entered into the ACL.

[<XXX>]

Client roles as required (as created under Administration — Clients).

[&F READALL]

Optional role. Allows access to all documents and eliminates the restriction
to clients.

Roles with the prefix &R have a hierarchical structure, i.e. lower level rights are included in higher

levels:
Level 4: [&R_MANAGER]
Level 3: [&R_KBMANAGER]
Level 2: [&R_EXPERT]
Level 1: [&R_CREATOR]
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Generally the Knowledge user requires the appropriate client role and one of the user roles which the
document was released for in order to have access to a document. An agent updates the
corresponding reader field. If the document has been released for all clients, one of the user roles
which the document was released for is sufficient.

3.3.2 Process editor

3.3.2.1 Expert:

All users stored as process editors can be used as experts for individual documents and for categories
([_Expert] role must be assigned in the ACL).

On request (by activating Newsletter for ExpertYes/No in the process editor document), experts will
daily receive an e-mail about newly assigned documents.

Process editors the Newsletter for Knowledge Manager option is activated for will receive an e-mail
about new or checked documents.

Every expert will find the documents assigned to him/her under Editing process > Expert (Own).

3.3.2.2 Expert group
Every group stored there can be used as expert group for individual documents and categories.

Role Description

[&R_KBMANAGER] Persons with this role can edit all documents and will therefore not be
requested to take over documents as expert.

[&R_EXPERT] Each member of the expert group can find the documents assigned to the
group under Editing process -> Expert (Own).

When clicking on Edit, persons with this role will be requested to take over
the document as expert.

3.3.3 Client

A knowledge document can apply either to a certain client or to all clients.
Initially, documents from HelpMatics™ ServiceDesk are restricted to their original client.

This restriction can, however, be removed or changed by a manager or expert during the editing
process.

Same applies to knowledge documents that have been newly created in the Knowledge Base. If the
creator has been entered as process editor, the client will be transferred as defined in the process
editor document. If not, the creator's roles will be examined: If exactly one client role is assigned to
him/her, this client will be transferred to the knowledge document; otherwise, the document will be
freely available to all clients at first, but can be restricted during editorial preparation before it is
released.

With the Client - New button you can add new clients. For each client created in this way, a role will be
entered using the abbreviation.

By double-clicking a client in the list you can edit his profile and provide it with an e-mail address
(Notes-Info tab).

3.4 HelpMatics™ Change rights

3.4.1 Access rights

All persons that are to edit data require the Editor access level with the Create personal folders and
views option. Furthermore, the availability of the ServiceDesk module has to be activated in the
process editor document (see chapter 4.9) . The individual rights of the persons are controlled via
roles:
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Role

Description

[&R_MANAGER]

This role permits persons access to Administration

[&R_CHANGEMNGR]

Change managers can create RFCs, changes and releases and edit
them and the associated tasks without any restrictions

[&R_DEMANDCREATE]

This role is required for submitting requests for change via the web
portal. To convey this right to all persons, the entry Anonymous is to
be added to the ACL, and this role to be assigned to it.

[&R_PROBLEMOWNER]

Problem owners can create new RFCs and changes as well as edit
these documents. However, they do not have the right to change the
status. Problem owners who create RFCs or changes from
HelpMatics™ ServiceDesk need this role in this module as well.

[&R_TASKEDITOR]

This is the role task editors require. They can edit all task data with
the exception of target expense and minimum task period.

[&R_1STLEVEL]

Helpdesk team members with this role can create standard changes.

[&F_REPORTING]

This role is required for accessing the reporting views.

[&F_PROFILE]

This role allows a person to edit the profile settings under
Administration - Categories - Validation, even if the type is set to
local under Administration - Modules - Enterprise. Otherwise these
profile settings can only be edited in the database identified as
central.

[&R_WTASKEDITOR]

This role is required for access to web tasks. Access as depositor
with read and write access to public documents is sufficient

[&F_READALL]

Optional role. Allows access to all documents and eliminates the
restriction to clients.

[&F REOPEN]

Optional role. Reopening of RFCs, Changes and Releases

[&F_QUICKCHANGE]

Persons with this role can create quick changes. You require at least
the [&R_1STLEVEL] role for later processing the changes you
created yourself further

To directly create quick changes based on a Cl, this role must also
be assigned in the CMS module (HelpMatics™ CMS Enterprise).

Roles with the prefix &R have a hierarchical structure, i.e. lower level rights are included in higher

levels:
Level 6: [&R_MANAGER]
Level 5: [&R_CHANGEMNGR]
Level 4: [&R_PROBLEMOWNER]
Level 3: [&R_1STLEVEL]
Level 2: [&R_TASKEDITOR]
Level 1: [&R_WTASKEDITOR]
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3.4.2 Configuration of task processing in the web

For task processing in the web, either access for registered Domino users or anonymous access can
be configured.

Type 1: Only for registered users

Persons that are users registered in the Domino directory and have an Internet password should be
added to a HMWebTaskEditor Notes user group.

Configuration of the access control list (ACL):

- The HMWEBTASKEDITOR user group gets DEPOSITOR access and the [&R_WTASKEDITOR]
role.

- The ANONYMoOUS ACL entry (if existing) does not get access

Type 2: Anonymous access
Persons that are not registered in the Domino directory get access via the Anonymous ACL entry.
Configuration of the access control list (ACL):

- The ANONYMOUS ACL entry gets DEPOSITOR access and the [&R_WTASKEDITOR] role.

- The HMWEBTASKEDITOR user group (if existing) does not get access

3.4.3 Configuration for submitting requests via the user portal

Submitting requests is configured under Administration-Portal-User portal (see chapt. 6.6.1).
Authentication can be defined here:

- Standard authentication means that the authentication defined under the authentication tab is
used. A login is required for submitting the requests and the requestor's data will be filled with
the login data by default. No additional adaptation of the ACL is required

- Anonymous means that irrespective of the setting in the Authentication tab access to the
request is possible without login. ACL item Anonymous does not receive access, can,
however, read public documents.
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3.5 HelpMatics™ Survey rights

3.5.1 Access rights

The assignment of roles to teams or persons controls the access of persons to different areas. The
persons should be assigned the EDITOR access level.

The following roles are important for HelpMatics™ Survey:

Role Description

[&R_MANAGER] Persons with this role have access to the survey and administration areas
as well as to the export of user e-mail addresses to the CMS.

[&F_REPORTING] If someone is to have access to the Reporting area, he/she requires this
role.

[&R_POLL] The DEFAULT and ANONYMOUS entries of the access control list are assigned

this role if the access level is Authors. This guarantees that every user can
answer questionnaires without authentication.

[&F_READALL] Optional role. Allows access to all documents and eliminates the restriction
to clients.

3.6 HelpMatics™ Configuration Management rights

3.6.1 Access rights

The helpdesk staff and the users of HelpMatics™ Change require at least READER access level as well
as the respective client roles or the [&RR_READALL] role.

Important roles:

Role Description

[&R_MANAGER] Access to ADMINISTRATION includes [&R_1STLEVEL],
[&R_2NDLEVELNEW] and [&R_PROBLEMOWNER] rights

[&R_1STLEVEL] Creation of incident tickets, creation and editing of Cls

[&R_2NDLEVELNEW] Creation of incident tickets

[&R_PROBLEMOWNERY] | Creation of problem tickets

HELPMATICS™ CMS ENTERPRISE:

When you use HelpMatics™ CMS Enterprise the visibility/editability of the License number for
software Cls field is controlled by means of a separate role.

Role Description
[&F LICENCE] Accesses to the license No. field

The use of the authorized user portal requires that the right to READ PUBLIC DOCUMENTS be assigned to
the -anonymous- entry.
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3.7 Access rights to other databases

3.7.1 Access rights to Admin database
HelpMatics™ managers and administration servers are assigned Manager access and the
[&R_MANAGER] role as well as the client roles.

All other HelpMatics™ users require Reader access, plus the right to read and write public documents
as well as the necessary client roles.

Read and write public documents is required for the FastText widget. This allows users without
Manager role to create private text modules.

The WRITE PUBLIC DOCUMENTS attribute is also required for sending e-mails from the web client.
For further details, refer to HelpMatics™ ServiceDesk.

3.7.2 Access rights to Portal database

The [&F_DEBUG] role shall only be granted to administrators/managers.

HelpMatics™ managers should be granted EDITOR access incl. delete rights. Alternatively, MANAGER
access can be granted.

HelpMatics™ process editors require read access for using the web client.

Depending on how the authentication of the portal/portals is configured, different settings are possible
for the ACL.

- Anonymous: No access, however reading and writing public documents possible
- User: Editor

3.7.3 Access rights to Transfer database

Database required exclusively for Enterprise use.

HelpMatics™ managers and administration servers are granted Manager access and the
[&R_MANAGER] and [&F_ReadAll] roles.
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4 HelpMatics™ database configuration

4.1 Database settings

The search function in the web client works with full-text index. For this reason full-text indexing should
be provided for ServiceDesk, Knowledge and CMS databases.

The database setting DOCUMENT LOCKING is recommended for the ServiceDesk and Change modules.
A background mechanism checks if document locking has to be removed. Single documents can be
added to this mechanism and do not have to be unlocked manually.

4.2 Mail-In database

Both HelpMatics™ ServiceDesk and HelpMatics™ Change have their own Mail-In area. A separate
Mail-In database has to be configured for each module.

The preferred mail format of the Mail-In database at the Domino server should be rich text. This
guarantees a reliable transfer of the e-mail text into the ticket when a ticket is created in the web from
the Mail-In.

4.3 Basic settings

Under ADMINISTRATION > MODULES, paths leading to other modules and URLs for web access
(complete URL) are set and stored. Here, also agent settings can be accessed in order to save the
date for the AUTOMATIC ESCALATION agent when, in case a ticket is escalated, a notification by mail is
to be sent (ServiceDesk).

If desired, colored flagging for escalated tickets can be configured via the color settings button. For
each run of the Automatic escalation agent, the escalation level reached is stored, if required;
provided that Allow Locking Documents is activated in the database settings.

Color settings

Background Text
Level 1: hd -Z
Level 2 i -Z
Level 3 = -Z

Mote: the settings refer to the “target date” column in the different views

Fig. 6: Color settings for escalated tickets

In the integration tab tab, you configure if MS-Office products shall be available, e.g. for Excel export
or printing.
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4.4 Mail template

Under TEMPLATES > MAIL you can create the mail templates you require for the following purposes:

Optional (ServiceDesk): Mail to user when a ticket is created and/or a ticket is closed (the mail
template to be used can be set for each client)

Mandatory (ServiceDesk): Notification for deadlines that have passed (the mail template to be used
can be set for each client).

Optional: Forwarding notification (ServiceDesk) or notification of task assignment and status changes
(Change) for process editors / teams (the mail template to be used can be set for each process editor
or team)

On request (ServiceDesk): Notification in case of manual (hierarchical) escalation (the mail template to
be used can be set for clients for each service level template).

On request (Change): Notifications concerning RFCs.

Mandatory (ServiceDesk): Notification in case of automatic escalation (the mail template to be used
can be set for each service level template).

Mandatory (Change): Change of status information of RFCs / Changes (the mail template to be used
can be set for each client).

Please note: The mail text can be formatted freely. Logos and attachments can be inserted. Avoid,
however, colored formatting of the placeholders used as this may cause an incomplete structure of the
mail text when the e-mail is created.

4.5 Service level template

Under Templates > Service Level the required service level templates are created (see chapter 7.3.1,
Service level template). A service level template is required for each client. It can, however, also be
used for several clients. If you want to activate service level monitoring for certain process teams, you
require the appropriate service level templates for them as well.

4.6 Client

At least one client document has to be created under Clients > Definition (see paragraph 6.5.1). For
the following reasons you should create several clients (also see chapters 3.1.2 and 4.6):

= Data security: Process editors are to have access to data (tickets, resources) of a certain
client only.

= Evaluation: You require separate evaluations for different clients.
= SLAs: You want to display different service level agreements for various clients.

4.7 Category and type

The terms to be used for categorizing tickets, RFCs, Changes and Knowledge solutions are to be
provided (see chapters 6.3, 7.2, 8.3 and 9.4).

4.8 Resources

User and configuration item data can be created manually for each client under RESOURCES > USER
and RESOURCES > CONFIG. ITEM, respectively. For this, select the client in the ComPANY tab
(ServiceDesk).

Usually, data from external data sources that is imported and updated per agent at night is used as
well.
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4.9 Process editors and process teams

Create the process editors first (see chapter 6.1). These are all 15t and 2" level team members
(ServiceDesk), experts and knowledge managers (Knowledge) as well as task editors, change
managers and other responsible persons (Change). One person may perform different tasks in
different modules. The availability in the individual modules can be set.

Then create the process teams and select the process editors for each team (see chapter 0).
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5 lIconsin the views

Icons play an important role in the overview displays of HelpMatics™ since they show information in a
compressed way. Thus, clarity of representation and reading rate are increased.

In order to work efficiently with HelpMatics™, you should first memorize the mostly self-explaining
icons. The following tables explain the icons used as well as their meaning.

Example:
- created on >~ |LUzer D Frocezs editar Caonfig. iterm no. =
* Glidden , Ainsley
I @¢ 10042006  alidden-ai Kaske , Peter [not agsigned)
@+¥ 09022008 nlidden-ai [Semice Desk)] 5004
&4+ 06.01.2006 nlidden-ai [Service Desk] [not assigned)
L @= 07.01.2006 nlidden-ai [Service Desk] [not assigned)
D@& 10122005  glidden-ai [Service Degk] [not agsighned)
@= 06.01.2008 dlidden-ai [U=er Administratior  [not assigned)
* Gould , Edwin
@@= 02032006 gould-ed [Semice Desk)] a001
@= 32122008 pgould-ed [Semice Desk] 1001

Fig. 7: Icons in the views

5.1 HelpMatics™ ServiceDesk

5.1.1 Priority
The priorities are transferred according to the settings under Administration > Clients > Definition.
Priority Icon Meaning
Priority 1 & Suggestion: asap
Priority 2 + Suggestion: very high
Priority 3 -+ Suggestion: high
Priority 4 Y Suggestion: Standard
Priority 5 + Suggestion: low
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5.1.2 Forwarding and returning tickets

Forward Icon Meaning

Workflow > Process editoritWorkflow > BB o % forward toisrprocess editor or process
Process team team

Workflow > Back to Process Owner | closed / user informed

Workflow > Back to Process Owner (T closed / user not informed

Workflow > Back to Process Owner | further processing required

Workflow > Back to Process Owner 4| incorrect ticket assignment

Please note: * (blue arrow) corresponds to the new icon in Notes 8

5.1.3 Automatic mail processing

Action Icon

Meaning

Mail from Mail-In automatically attached to ] -
the ticket

5.1.4 Status

Status Icon Color

closed & green
work in progress yellow
open red
on hold violet

blue

grey

assigned external

T 08 & @

scheduled

5.1.5 Date

E-mail attached to the ticket and process
editor informed, if required.

Date

Icon

phone: e.g. call-back date
fax / mail: response by fax or e-malil
on site: e.g. appointment with user

reminder

= % O @
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5.1.6 Ticket
Meaning Icon
master ticket or master info El

sub-ticket

problem ticket

5.2 HelpMatics™ Knowledge

FRO

Meaning Icon
FAQ document 7]
Document relevance. Depending on the read
count, use count, rating and up-to-dateness, the %
document is provided with O to 3 stars
5.3 HelpMatics™ Change
5.3.1 Priority
Priority Icon Text
High priority + Suggestion: “high”
Normal priority Y Suggestion: “normal”
Low priority + Suggestion: “low”
5.3.2 Status
Icon Color Status/RFC Status/Change Status/Task
b4 red rejected rejected closed (system)
L green authorized reviewed -
& green processing completed processing completed closed
&> yellow processing: active processing: active work in progress
L red new new open
& violet processing: on hold processing: on hold on hold
- gray ) - inactive
= red - - on hold, trigger for a
workflow interruption
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6 Administration of HelpMatics™ - General

6.1 Process editor

This view displays a list of all persons working with HelpMatics ™:
=  Helpdesk team members (ServiceDesk)

= Experts and knowledge managers (Knowledge)

= Task editors, change managers, executors ... (Change)

With the PROCESS EDITOR - NEW button you can add a new process editor. Every person working with
HelpMatics™ has to be entered there along with the modules available to him/her. Via the ADDRESS
BOOK button you can transfer the process editor's data from a Notes address book.

With a double-click on a process editor in the list, you can edit his/her profile.
For information on how to automatically create/synchronize process editor data refer to chapt. 11.2.

6.1.1 General data tab

= The spelling of first name and last name must correspond to the entries of the Notes address
book, with the contents of the MIDDLE INITIAL field being suffixed to the first name. Process editor
names consisting of more than 38 characters will be displayed with only 38 characters in the
processor list of the documents for the sake of clarity.

= The process editor's initials may comprise 2 or 3 digits and are used for generating ticket ID, RFC
ID and Change ID (<client>-<time stamp>-<process editor's initials>).

= Via the client of the process editor, client-specific information can be retrieved, e.g. address of
sender, if the mail template used is configured accordingly. Moreover, process editors will only be
displayed to users with appropriate client role (multi-client capability).

ENTERPRISE:

Here, the client has the following additional function: If a ticket is forwarded to a process editor whose
client has not been defined as a role in the current database access control list, the availability in the
ticket is to be set at least to CENTRAL to ensure the data exchange.

It additionally includes the Availability item to specify the databases in which the process editor shall
be available. LocAL (in the current database only), CENTRAL (in the current and the global databases)
and GLOBAL (in all databases).

Please note:

The GLOBAL setting cannot be undone (except by deleting and newly creating a data record).
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Notifications concerning e.g. tickets directly assigned to the process editor (ServiceDesk), knowledge
newsletters (Knowledge) and information on task assignment or changes of status (Change) will be sent
to the e-mail address. It can moreover be used as address of sender e.g. for sending an e-mail to the
user if the mail template used has been configured accordingly (also see 6.4).

There is the option of storing a sender address. This is preferred to the use of the e-mail address if a
mail template with Current Process Editor option is used as sender address.

The e-mails can be sent via Outlook or HCL Notes. This applies to both mails that are generated in the
ticket via the MAIL button and mails that are automatically generated when the ticket is forwarded to
another process editor/team. If the e-mails are to be sent via the Domino server, select HCL Notes. If the
local Outlook client is to be used for sending the e-mails, select Outlook.

Calendar entries can be made in the Outlook calendar or in the Notes calendar. This refers to the
transfer of dates set in tickets.

6.1.2 ServiceDesk tab

Service level monitoring can be switched on or off. If service level monitoring shall be activated for the
process editor, you can specify the corresponding service level template there. Please note that the
settings of the assigned process team are primarily used. Only if the process team which is responsible
for the ticket to be monitored cannot definitely be determined, will the settings of the process editor be
used.

E-mail notification when a ticket is assigned: Here you can activate e-mail notification of the process
editor, select the mail template and specify which link to the ticket is to be attached. Explanation of the
links:

o NoOTES MAIL: Link that only works within the Notes mail system.

o Other E-Mail Clients: Creation of a file attachment leading directly to the task when it is opened
(also works with other mail systems)

o Web: Web link to the ticket (requires web access activation at the Domino server)

Even if e-mail notification has not been activated for the process editor, escalation mails are sent to the
specified e-mail address.

6.1.3 Knowledge tab

Newsletter for Knowledge Managers: This setting refers to sending the daily newsletter to knowledge
managers.

Please note: Knowledge managers require the [ MANAGER] role in the Access Control List in order to be
able to perform their function completely.

Newsletter for Experts: This setting refers to sending the daily newsletter concerning newly assigned
solutions and FAQs to experts.

Please note: Experts require the [ _EXPERT] role in the Access Control List in order to be able to perform
their function completely.

6.1.4 Change tab

E-mail notification when a task is assigned, when task processing is put on hold or canceled or when the
target time has been exceeded: Here you can activate e-mail notification of the process editor, select the
appropriate mail template and specify which link to the task is to be attached. Explanation of the links:

o NOTES MAIL: Link that only works within the Notes mail system.

o OTHER MAIL CLIENTS: Creation of a file attachment leading directly to the task when it is opened
(also works with other mail systems)

o Web: Creation of a web link for editing a task on the web
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6.2 Process teams
In this view all process teams and their respective members entered under PROCESSORS are listed:

®  Helpdesk team members (ServiceDesk, CMS)
=  Experts and knowledge managers (Knowledge)
= Task editors, change managers, executors ... (Change)

II:Pj Qpen EPmcessteam- e ;‘ Print
Team - Members {max 9 dizplaved) Client ~ Department ~ ServiceDesk
Administration
P Knowledge
back ¥ ServiceDesk
Application Service Haberland . Morbert COCAG IT-Service .
P Lang. &rnold
rocessors M
P dit
e Central Purchaze Raabe ., “Walter COC AG Development x
Cuieantine Zimmer, Andreas
2 Communication Leitl, harco COCAG IT-Service x
Templates
Clients Scholl . Stephan
Portal Hardware Suppart Blinker, James COC AG Hardware x
Modules Braun, Zacharias
Mai Infrastructure Dupree, Frederic COC AG IT-Service x
aintenance . i
Hel Liebezeit. Bernhard
b On Site Service Aicher, Bernhard IT Pride Externer x
Gatwick . Robert Dienstleister
Operative Service Bartels . Alexander COC AG IT-Service x
Leitl, harco
Problem Management Bartels , Alexander COCAG Problem .
Zieglgaenzberger, Hans Mangerment
C SAP Basiz Services Ballauf, Christoph COCAG Development .
© 2006 by COC AG ‘? Ost. Hubert

Fig. 8: Process teams

By clicking the Process Team - New button, you can create a new process team. Via the MEMBERS button
you can select the members of the team.

By double-clicking the document you can edit a team.

For information on how to automatically create/synchronize process editor data refer to chapt. 11.2.

6.2.1 General data tab
=  The name of the team must not consist of more than 38 characters.

= Ateam must be assigned to a client. This assignment is necessary for read access: Process teams will
only be displayed to users with the appropriate client role (multi-client capability).

= Notifications concerning e.g. tickets that have been assigned to the process team will be sent to the e-
mail address(es). Several e-mail addresses have to be separated by semicolons.

= The Department field is also part of the process editor document. It is used in some views to sort tickets
by the department of the process team or process editor.

= Is a process team available for HelpMatics™ Change, a question will be asked upon changing the
members as to if this change is to be transferred to active change documents. If a change document is
blocked, no update will be made. Otherwise the update will be made immediately.
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— —
ENTERPRISE:

It additionally includes the Availability item to specify the databases in which the team shall be available.
Local (in the current database only), Central (in the current and the global databases) and Global (in all
databases).

PLEASE NOTE:
The Global setting cannot be undone (except by deleting and newly creating a data record).

6.2.2 ServiceDesk tab
=  Service level monitoring can be switched on or off. If it is to be activated for the process team, you can
specify the corresponding service level template there.

= The e-mail notification feature requires that the MAIL TEMPLATE to be used be selected and that the types
of links to the ticket to be included in the notification e-mail be defined.

=  Even if e-mail notification has not been activated for the team, escalation mails will be sent to the
specified e-mail addresses.

6.2.3 Knowledge tab

= Newsletter for Experts: This setting refers to sending the daily newsletter concerning newly assigned
solutions and FAQs to expert groups.

6.2.4 Change tab

= E-mail notification when a task is assigned and when new information on the task is available (also see
6.1.4).

HELPMATICS™ CMS ENTERPRISE:

6.2.5 CMS tab

For Cls there is a separate rights concept available via the HelpMatics™ process teams. For this purpose, all
HelpMatics™ process editors have to be added to process teams.

This rights concept is a combination of access rights from the ACL (e.g. first-level rights) and rights to
create/edit/delete Cls via the HelpMatics™ process team (e.g. for Cl users of client xyz).

By default, only persons with the [&R_MANAGER] role may create, edit and delete Cls and establish
relations or edit teams.

Persons or teams which the [&§R_MANAGER] role has been assigned to via ACL are not affected by the
rights concept on process team level.

Type: For each process team a separate configuration can be made as to which ClI types this team may
create/edit/delete. For deleting ClI types, the right to delete documents has to be activated in the ACL.

Client: This right can be restricted by specifying a client.
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Relation: Group documents may be saved depending on the respective rights on Cls.

Example: If rights have been assigned for User Cl and COC client, user groups of the COC client can be
edited and saved.

Additionally, ClIs for which no rights have been assigned may be added to or removed from the group. No
changes will be made to the original ClI document.

Process team BN -y

General datal SenviceDesk I CMS I

Processing rights

Type: "User
Hardware
Documentation ;=
Client: TCOC AG ;=
Relation:

Fig. 9: Process team rights in CMS

The rights of each process team will be added up.

Example:

Process editor X has been added to groups A and B.

Group A has rights on users and hardware of the CAT client

Group B has rights on software of the CCH client.

Consequently, process editor X may not create/edit/delete users of the CCH client.
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6.3 Categories

6.3.1 Type
Here you find a list of defined types.

E@Dpen _,-‘;_Jr'gT].fpe—New ._"_;'aF'rint

Holpr-Maki<s

Type ~

Diescription

v

Service Reguest
Solution - Handling
Solution - Known error
Solution - Work-around

¥ SemviceDesk
Event
Incident
Problem 1 - Unknown Error
Problem 2 - Known error
Problem 3 - Reguest for change
Service Reguest

Fig. 10: Category type

By using the TYPE - NEW button, you can add a new type; a list informs you about already existing types.
By means of the Use in process information you define the process times to apply to this type. You set these

times in the service level template for clients in the Advanced configuration.

ENTERPRISE:

It additionally includes the availability item to specify the databases in which the type is to be available. Local
(in the current DB only) and global (in all databases).

COC AG

HelpMatics™
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6.3.2 Main category

Choose short, precise terms for the main category.

@ Qpen *Main category - Mew %Subcategur\r— e &Print

Main categare - |Subcategory1 |Subcategory 2 ServiceDezk |Knowledge |Description
¥ Knowledge

¥ Clientdoplication X X Anplication Client
Acrobat Professional x x Adobe Acrobat Professional
Acrobat Reader x x Adobe Acrobat Reader
Helphdatics: x x Helphdatics Yerzion 5.1
Lotus Motes x x Bt Lotus Notes
IS Access x x Microzoft Office XP Professional
kA5 Excel x x Microzoft Office XP Profezgional
IS Internet Explorer x x hicrozoft Internet Explorer
IS Qutlook x x Microzoft Outlook
IS Powerpaint x x Microsoft Office XP Professional
kS Project x x Microzoft Project
A5 Yizio x o MicrosoftYisio
bAS Word x X Microzoft Office XP Professional
SaP GUI x > GLI SaP Ri2
Trend kicro x x Trend Micro OfficeScan

P Client Hardware x x Hardware Client

P Client Operating System x x Operating System Client

b Metwark Infrastructure x x Configuration lterms MNetwork

b SaP RS x x SAP R/3 - global

Fig. 11: Main categories and Sub-categories

This view lists all main categories that your staff can use for roughly categorizing a problem.
With the Main Category - New button you can add a new main category.

If a category is not assigned to a client, it is displayed under DEFAULT SET and available to all clients for
which no category set has been defined.

Note:
If a category set has been defined for a client, you should create ticket templates for this client as well,

since, in this case, a sensible default category setting is only possible for client specific ticket templates.
As regards portal ticket templates, it is essential to observe this procedure. Invalid configuration may
cause failure in creating tickets from the portal!

Actions:

- Use the Main category — New button to add a new main category.

- To create a new subcategory, move the cursor to the superior category and click Subcategory — New on
the action bar.

- Create copy: Client categories or default set categories can be copied to a different client. This makes
creating category trees per client easier. In the copying process, all existing categories of the target
client can be deleted.
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Create copies of categories E

Copy categories (default set or for client)

from the client or default set:
) |Default Set |

for the following client or default set:

D |CUC Germany AG |

Create a copy Cancel

Figure 12: Copy feature for categories

With a double-click on a category in the list, you can edit it. In both cases a window appears which, in the
edit mode, contains, among others, a list of already existing categories of the same level.

Changes to categories will be transferred to the subcategories.

A default process team can be assigned to a main category for ticket processing. The default process team
will be passed on to the subordinate categories.

A subcategory can only be made available in a module if the superior category is available. If a superior
category is not available in a module, its subcategories will not be available either.

HELPMATICS™ CMS ENTERPRISE:
You can assign one or several services to each category level. To do so, use the ASSIGN button.
When you select a category in the ticket, the more specific service is used.
Example:
Main category — no service stored
Subcategory 1 - Service A

Subcategory 2-1 — Service B

Subcategory 2-2 — no service stored
When you select subcategory 2-1, service B is used, when you select sub-category 2-2, service A is used.

If a service is assigned to a ticket template, this will be used in the ticket.

ENTERPRISE:

It additionally includes the Availability item to specify the databases in which the main category and its
subcategories are to be available. Local (in the current DB only) and global (in all databases).
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6.3.3 Subcategories 1 and 2

Your team members can use the subcategories to characterize a problem in greater detail.

To create a new subcategory, position the cursor to the superior category and click Subcategory — New in
the action bar.

A subcategory inherits the default process team from the main category, or a default process team can be
assigned to the subcategory for ticket processing.

The figure below shows the window for creating another subcategory 1, with Client Application being the
main category.

I:(Eiolose HSave &Asmgnment

Subcategory1

ettings Xisting subcategories

Awailable in module: ¥ ServiceDesk M Knowledge [ Change Acrobat Professional 1=
Acrobat Reader

Main category: IC\iem Application j Helphatics

Lotus Motes

Mame T 5 M5 Access

WS Excel

Expert: WS Internet Explorer

MS Outlook

Description: r WS Powerpaint

MS Project

MS Visio

WS Word —
SAP GUI

Fig. 13: Subcategory 1 window in edit mode
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6.4 E-mail templates

Under Templates > E-Mail, templates for e-mails can be defined which can be used in the HelpMatics™ mail
workflow (e.g. as e-mail to a user or an external service team member). After clicking the E-Mail action
button, the e-mail templates that have been defined to be of Public type will be displayed for selection in the
document window. If there is only one e-mail template, this will be used automatically.

E-mail templates of Administrative type can be assigned e.g. to process editors and process teams and thus
be used for the transfer of information within e-mails. In this way you can assign e.g. a specially designed e-
mail template to a process editor who want to be informed about new tickets by SMS. (For this, the e-mail
function of the mobile phone must be activated and the e-mail address of the process editor be entered. Only
the e-mail subject will be transmitted. The charges will be borne by the mobile phone owner). Further
applications of administrative e-mail templates are process editor escalation and client escalation (service
level template selected in the Monitoring tab).

With the E-Mail Template - New button you can add a new template. Define your e-mail template like this:

E',ECIDSE HBave L“Elnsenﬂelds i/E—mailtemplate info

-

E-mail templ.

ate

Ayailable in module: ™ SericeDesk ™ Knowledge W Change
Marne: " Request rejected

Type: & Public © Administrative
Recipient's address W transfer e-mail address from field

" RequesterMailaddress

Address of sender. |c\‘gm e

Subject: “Your Reques is rejectad
E-mail text fformatable) " Dear Mrfrs, <RequesterFullnames,

“rour Reques "<BriefDescription>" is rejected
Feason

Kind regards
<Session.Commonllsermames

Cl

4:

ktiengesellschal

£

Fig. 14: How to create a new e-mail template
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a) General information

Field name Description

Available in module Regulates the availability of the template in the individual HelpMatics ™
modules

Document type If the template is intended for use in the Change module, make a
selection here

Name Name of the template (will be used for selection in the ticket, RFC,
Change or task)

Type Public: E-mail templates that will be offered for selection in the

documents after clicking the E-Mail button .
Administrative: E-mail templates for notifying process editors/teams and
escalation mails can be defined.

Recipient’s address The recipient's address is only available for mail templates of the public
type. You can automatically transfer the user's or reporter's e-mail
address from the ticket with a <Field name> placeholder. In addition you
can indicate definite e-mail addresses. Multiple values are separated by
semicolon.

Address of Sender E-mail address of the e-mail to be sent. Besides the address of the
current user (stored in the process editor document) also the e-mail
address stored in the document of the client of the user or of the client
of the process editor can be used.

Subject The subject of the e-mail You can use placeholders for fields here (see
below for how to proceed).

b) E-mail text

Text of an e-mail. This text can be formatted.
Here as well, you can integrate placeholders for existing field values in the ticket (see below for how to
proceed). If Notes Malil is used, file attachments inserted here will also be transferred to the e-mail.

c¢) Use of placeholders

It is possible to automatically transfer existing field contents of the ticket into the subject or mail text of an e-
mail. When the e-mail is generated, these placeholders will be replaced by current values.

Using the Siminsertfields pytton you can insert aimost any fields. To do so, position the cursor to the

desired position in the text and select a field via Insert Fields.
Alternatively, you can enter the field name put in <> (e.g. <ReferenceNumber>) at the desired position.
When formatting text, don't use different formats for a placeholder including the angle brackets.

Via Insert Fields a direct link to the ticket information in the user portal can be integrated. Choose the entry
PORTAL LINK TO TICKET.

If several portals have been configured, a choice of portals is available in the next step. Select the portal the
link is to be generated for.

These settings also apply to the Change module.
| I
ENTERPRISE:

Administrative e-mail templates are categorized as local or central, depending on their place of creation.
Central templates are available in all databases. Local templates are available in the central database and in
the local database in which they were created.
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6.5 Clients

6.5.1 Definition

In the Clients > Definition view you can see all clients whose members are supported.

With the Client - New button you can add a new client.

By double-clicking a client in the list, you can edit his profile. A description field is available in which you can
also insert attachments.

= General

Here you define the service level template where information on ticket monitoring and process times is
stored. Having selected a service level template, you can display its contents by clicking the % Display
button.

=  ServiceDesk

Here you can enter the sender's e-mail address (e.g. e-mail address of the helpdesk). If answers to
HelpMatics™ mails are to be sent to a different address, configure Answer to.

If e-mail assignment is activated, an e-mail with a valid ticket ID in the subject is automatically assigned to
the ticket and marked in the views.
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General data' SemviceDesk I

E-mail of sender: "senicedesk@coc-ag.de |
Reply to: "
E-mail assignment: ¥ attach to tickets automatically

Mail Management

Creation of incident

E-mail to User? v Yes

E-mail template:

Closing of incident

E-mail to User? W Yes

E-mail template:

Deadline elapsed

E-mail template:

Mote: E-mail notification to current process editorteam when the deadline has been exceeded
and in case of autematic change of status (status "on hold™ -= status "work in progress”).

Fig. 15: Client-specific settings for the ServiceDesk module

E-MAIL TO USER? (at ticket creation and closing)ist!

If these options are activated, you have to select a mail template that is to be started automatically when a
ticket is created and a mail template that is to be started automatically when the ticket is closed. If both
options are activated, only Mail to User will be started immediately when the ticket could be solved
immediately and is closed.

If not a user, but a reporter is stored, the reporter will be informed.

It is mandatory to indicate an e-mail template for DEADLINE ELAPSED. The e-mail is sent as soon as the date is
in the past and the status is set from on hold to work in progress.

= Change

You can enter the sender's address here. If answers to HelpMatics™ mails are to be sent to a different
address, configure ANSWER TO.

Store the mail template required for sending status information to change managers, sponsors, executors
and requesters of an RFC / Change. The persons to be informed can be set individually in the RFC / Change
document.
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6.5.2 Holidays

Here you'll find a list of all holidays when there is no support, i.e. when there is no ticket processing. By using
the available buttons you can add and edit holidays.

Holidays are not counted as process time. This has an effect e.g. on the calculation of the target times and
the calculation of the time actually required for solving a ticket.

6.6 Portal

6.6.1 User Portal

Here you can define User Portals which, depending on the configuration, allow users to:

- receive news from the info management

- search FAQs,

- report service requests or incidents and/or create tickets,

- retrieve information on their own tickets,

- send requests,

- if HelpMatics™ CMS Enterprise is used: display service catalog

Access to some areas of the user portal can be configured as anonymous or authenticated. This applies to
the areas of FAQ and service catalog. Ticket tracking and ticket delivery requires authentication (Notes
authentication, authentication via e-mail or LDPA). Requests can be submitted either by authentication (as
set in the Authentication tab) or anonymously.

COC AG HelpMatics™ Page 44 of 121



u
Administration of HelpMatics™ - General H '.- I' r' m dt ] ‘ 5

6.6.1.1 Requirements for using the web portal
o JavaScript must be activated in the browser.

o Inthe case of non-anonymous access, SINGLE SERVER must be activated in the Domino
web access area of the server document.

Mews FAQs Send request Request tracking Mewsletter

Welcome to User Services at COC AG

Service Center

This is the portal of the COC Service Center

Contact us at:
+49 (0)BE6TT 1 9747-402 or
servicedesk{@coc-ag.net

Owr office hours are:
Monday to Friday 7:00 a.m. to 1900 p.m.

This service is based on HelpMatics by COC AG
hittp:ffwww. coc-ag.de
hitp/f'wearw helpmatics.com

Fig. 16: Example of a user portal

6.6.1.2 General settings
You create a new portal definition by clicking PORTAL — NEWw:

An individual Web Link will be generated for each portal that can be made available to the respective users.
This link will be available after first saving. Via the Regenerate link button you can regenerate this link. If you
want to display your own logo, attach the corresponding file (file type: JPG or GIF) via the Attach Logo button
to the document.

Individual portal pages can also be integrated via an individual link, e.g. into an Intranet page: By clicking
Direct Link in one of the tabs you'll get to the relevant page.
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6.6.1.3 Design
The design of the portal is defined there via a style sheet file (hm_portal.css).

EgiCIDSE HSave %Hegenerate link .-’-‘n.ttach logo -E-')F'Drtal info

Portal definition

General data' Design I “WWelcome page | Info | FALC | Newsletter' Ticket delivery I Ticket Tracking I
Default design:  Yes & No

F
Style sheet: r‘}

hm_partal.css
Loga: g @
logal.jpa q

Wig the button 'Attach loga' Only import one image (PG of GIF) as file sttachment.
Recommended max. size: 150x150 pixels; displayed on the introduction zcreen.

Fig. 17: Storing css-file and logo in the portal document

If the default design with configuration as per delivery is to be used, select Yes in the Default Design field. If
you want to adapt the portal to your requirements or wishes, open the style sheet file by double-click and edit
it in the editor.

Alternatively, the file can be stored locally in the file system and edited by any text or style sheet editor. After
editing, the file is to be copied into the field again.

If you made a mistake when editing the file or want to restore the DEFAULT DESIGN, click the Yes button under
Default design. As soon as you click Save, the delivery status of the original css-file will be restored.
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6.6.1.1 Welcome page

Define the contents of the welcome page here. Formatting is made via css in the specified design. If you
want to use other formats in the text / parts of the text of the welcome page, check the HTML box. This
allows you to e.g. highlight individual words or insert links.

Text: “This is the portal of the <b>COC Senice Center</b=<br><br=

Contact us at:<br=
+49 (0)8677 / 9747402 or<br=
senvicedesk@coc-ag.net<br=<br=

Our office hours are:<br=
Monday to Friday 7:00 a.m. to 19:00 p.m.<br==br=

This semnvice is based on HelpMatics by COC AG=br=
=a href="http:/fwww_coc-ag.de’=http:/fwww_coc-ag de</a=<br=
=a href="http:/fwww_helpmatics com'=http://www_helpmatics com=/a= |

Text formatting: W HTML

Fig. 18: Formatting the welcome page using HTML

6.6.1.2 Info
Here you can activate the display of info from the SERVICEDESK info board. Only information for which
Display in Portal has been activated will be displayed.

6.6.1.3 FAQ

If you want to be linked to your knowledge base, you can activate FAQs. FAQs are accessed either
anonymously or with authentication via user ID and password.

Please note: As soon as a user to be authenticated is shown in the FAQ area, ticket tracking and ticket
delivery can only be made via e-mail authentication.

If Notes authentication has been set here, it is recommended to activate Anonymous in the portal definition
for FAQ access. If the ACL of the portal database does not allow access for ANONYMOUS, Notes
authentication will also be required for FAQ access.

Besides a convenient search function, the portal offers the user the option to evaluate FAQs. You can define
the labeling of the corresponding buttons and message texts yourself.

6.6.1.4 Newsletter

Via a mailing list with optional (de)listing, current information can be selectively circulated to the users. The
mailing lists are accessible in HelpMatics™ Knowledge under Editing Process > Newsletter Subscriptions.
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6.6.1.5 Ticket delivery

If ticket templates have been released for the relevant portal, users can create tickets directly by using these
templates. Released ticket templates are visible in the portal definition.

If no templates have been released for the relevant portal, text fields will be offered to the user for entering
his/her data and the request. In this case an e-mail will be sent to HelpMatics™ ServiceDesk (Mail-In). By

activating Send e-mail info to you can inform by e-mail any persons or teams you like on the filing of a new
request.

Besides the default mandatory fields First name, Last name, Phone, E-mail and Description, you can provide
additional fields. Here, too, you can define the labeling and the buttons according to your wishes.

Access to ticket delivery is granted either via Notes or via e-mail authentication. This setting is made in the
Authentication tab.

Ticket delivery is authenticated as configured in the authentication tab.

6.6.1.6 Ticket tracking
Here the users of a portal get a list of their own tickets. The tickets include:

- Incidents, problems and service requests
- Requests
- RfCs and changes.

You can define which ticket data is to be displayed and how the labeling is to look like. The name of the
editor processing the ticket is made anonymous in the request, processing and solution fields.

Using three search fields you can filter according to different criteria:

- Type
o Tickets (my own)
o Tickets reported for other persons
o Your own requests
o Requests reported for other persons
(@]
- Status
o in preparation
o active
o closed

- Full text search

You store the labeling in the portal definition.

During ticket processing the user can make comments. Depending on the configuration, the comment is
transferred directly to one of the fields, i.e. request, process or solution fields. If configured for the process
editor, the editor processing the ticket will receive a notification.

Access to ticket tracking is granted either via Notes or via e-mail authentication. This setting is made in the
Authentication tab.

Ticket delivery is authenticated as configured in the authentication tab.

The direct link leads you to the ticket overview. After having logged in the user gets a list of his/her own
tickets.
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Tracking
Select type Select status Enter search term k_'l\\
my own tickets
fickets reported for others Brief description
My oW requests AAL HelpMatics: Request of function from customer
requests reported for others DEt Wrong proxy server settings
o CHA-181012101137-w53 Administration: New Employee

Fig. 19 Ticket tracking with filter

This information can also be retrieved via the direct link for ticket tracking.
Example of a ticket tracking link:

http://server/path/xpSoloPortalTrackingAuth.xsp?action=openDocument&documentld=C12571240037E122C
12574560039ADF2

When configuring mail templates you can provide a direct link to a ticket for the user. (see chapt. 6.4). Create
the ticket link via the INSERT FIELDS — FIELD NAMES OF A TICKET — PORTAL LINK TO TICKET function. The
document ID parameter contains the ID of the portal. Please note that this parameter takes a different value
for each portal defined.

Example of a link leading directly to the ticket information:

https://server/path/xpFormTicket.xsp?documentld=39D46AA4099A23ECC1257B6C002BBC76&TicketDocld
=<TICKET>

If this link is inserted into the text of a mail template, the <Ticket> parameter will be replaced by the ID of the
current ticket when the e-mail is generated:

Example of a complete ticket link:

https://server/path/xpFormTicket.xsp?documentld=39D46AA4099A23ECC1257B6C002BBC76&TicketDocld
=C7BA46929D6DF4ABC1257C140030CE9F
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HELPMATICS™ CMS ENTERPRISE:

6.6.1.7 Service catalog

The service catalog is only available in HelpMatics™ CMS Enterprise. Cls of the Service type can be
provided with additional information for the end user and can be listed in a service catalog. These settings
are stored in the CMS Enterprise. The service catalog can be made available to the user via a portal.

Senvice catalog: iy Description: " Description

Labeling navigation: " Senice catalog 4 J‘aﬂ\\«'ailahilit;uﬂ @ J—a"3\\«'ailahilitgu
Heading 1: " Senice catalog 4 J‘Responsihlilit}ug EiSrResponsthilityJ
Text: g " SenviceDesk info ;= 2 " SeniceDesk info
[Back] button: "Back " Price info = 2 Price informationen

Fig. 20: Service catalog configuration

Here you define the labeling, descriptions and their order. Access to the service catalog can be made via
configured authentication (see Authentication tab) or anonymously - without any authentication.

6.6.1.8 Web request form

Web request forms will only be visible when a web request form has been configured in HelpMatics™
Change and released for the desired portal (cf. chapt. 9.5.1Error! Reference source not found.)

Web request forms can be submitted either by authentication (as set in the Authentication tab) or
anonymously.

COC AG HelpMatics™ Page 50 of 121



Administration of HelpMatics™ - General m

6.6.1.9 Authentication
Ticket delivery and ticket tracking are only possible for authenticated users.

Authentication is made via Notes or via a combination of e-mail link and cookie. Based on the authentication,
the user's e-mail address is determined. The login to the portal will only be successful if a unique user is
found in the CMS on the basis of this e-mail address.

a)

b)

c)

Notes Authentication
The process editor logs in with his/her Notes account.

E-Mail Authentication
After having entered his/her e-mail address the user gets an e-mail with a personalized link. The
Iogin data can be saved permanently (cookie).

Authentication:  Motes ! Login error: "You could not be identified as HelpMatics
USer. ;

Labeling: " Enter valid e-mail address. Labeling for user: " logged-in user:

[Request link] button: "Request link [Save login] button: " Save user permanently

Confirmation text: " The link will be sent to you.. [Delete login] button: " Delete login

Subject of e-mail: "Login to HelpMatics Portal Validity of login: 730 ,Days

E-mail text: " Follow this link <Link> to open the User Portal.
|

Fig. 21: Configuration of e-mail authentication

LDAP authentication
The user logs on with the LDAP user data (e.g. if connected to the active directory, the user logs on
with his/her Windows user/password).
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6.6.2 Service cockpit

This area allows you to create service cockpits (see also Ticket monitoring in the service cockpit 2.0).
A service cockpit provides a quick overview of all KPIs (key performance indicators) for the incident manager
(or servicedesk manager, etc.):

The number of tickets per day is displayed under Ticket volume. In client monitoring you can see
immediately how the ticket volume is divided into the different monitoring levels. Further charts show
resolution rate, process time, user satisfaction and any other KPI. The light-gray pointer indicates the
average of the past (period can be set — 1 to 3 months), the dark-gray one the average of the past 24 hours.
The data will be updated regularly in configurable periods in the background.

[ HeLp Iiiakics] Demo Service-Cockpit 17.11.2005 16:54
Ticket-%olume Resolution-Rate Process-Time
- 25% ! 75% 350 ! 1 050
24 [ .
s e s s
18
0% o = 100 0 S — 1400

Days

Client-Manitaring User satisfaction

on hald in time Lewel 1 Level 2 Level 3

Fig. 22: Service cockpit

6.6.2.1 General
Name and heading of the service cockpit are to be entered there.
The Web link will be generated automatically when saving. In this process the Web link data under
ADMINISTRATION > MODULES is accessed.
Furthermore, filter settings (according to client and the department of the responsible person/team) as well
as the settings for determination of average and for background color are made. Determination of average
refers to resolution rate, process time and user satisfaction.
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6.6.2.2 Chart configuration
afgcioe Hssva.ﬁiitachmam

General data ‘ Chart configuration I
I
Heading ““alume of Tickets Heading: " Resolution rate Heading "Ticket processing time
Lavwer limit: rDJ Lawer limit: rDJ Loweer limit: rDJ
Upper valug: 72500, Upper valug: o0, Upper value 0,
Threshold: 71500 2000 Threshold "B0,80, Threshold: a8,
History in days: 730, Immediate resolution (Field " “Incident 1 - Immediate
Type") resolution
Description: 5 g Description 5
*The current value (dark arey) refers to incidents crested during the past 24 * The current walue (dark orey) refers to incidents created in the
hours, past 24 hours.
[“Client monitoring * ===
Heading " Client monitoring Heading: "User satisfaction Heading 5
Lavwer limit: rDJ Survey: rJﬂ Loweer limit: rDJ
Upper value: 2600 Lower limit 0, Upper value 00,
Threshold: 71000,1500 Upper value: 100, Threshold: 60,80,
Mumber of values: rABJ’ Threshold rED‘BDJ File with values: rJ’
Description: g Description: o
* The resulting period depends on the agent settings #The current value (dark grey) refers to the questionnaires that have been * Attach a text file, separated by commas, here.
The agent runs every 30 minutes by detauk. L., exactly 1 day is answered during the past 24 hours

displayed in case of 48 values.

Fig. 23: Chart configuration

Labeling and thresholds of the individual KPIs to be displayed can be defined there. In the Volume and Client
Monitoring charts, vertical lines will be drawn in for the thresholds, in the other four charts, the color of the
scale will change for the thresholds.

e Volume
This allows you to keep track of the number of tickets received recently.
e Resolution rate

Here the share of immediately solved incidents in the total number of incidents is shown. In case of
immediate solution, the status changes from open to—>closed.

e Process time

The average process time is plotted in minutes.

¢ Client monitoring

Here you see the development of the ticket numbers in the individual monitoring levels over the last up to
100 agent runs. Depending on how often the agent runs, a short or long period of time may thus be
illustrated.

e User satisfaction

Here a survey created in HelpMatics™ Survey can be interpreted. The average of the graded questions of
each answered questionnaire flows into the values shown by the indices. Therefore, please make sure that
the same scale is used in a questionnaire with several graded questions.

e Freely configurable

You can attach a text file with two values separated by comma. The first value is symbolized by the dark
gray, the second one by the light gray index.
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6.7 Maintenance

6.7.1 Replication conflicts

In this view you can see the conflict documents: If two persons edit one and the same document and store it,
there will be a version conflict; as a result a so-called conflict document will be created, which then appears
in this view.

To find out which of the two documents, conflict or main document, contains the currently valid information, it
is necessary to determine which field change(s) has/have led to the replication conflict.

This can easily be ascertained by using the Compare Fields button after one conflict document has been
selected. For this purpose, position the cursor to the line [replication or storage conflict]. After activating the
button, a list of the fields concerned and their contents will be displayed in a dialog window. Notes-specific
fields with “$” prefix do not have to be taken into account.

@Open EConﬂictlmain document EjCOmpareﬁelds ";;Print

lForm | last change | 1D/ name'| last editor | brief description

v User | 06/28/2005 04:38 PM | 'Lamb, Paul' | Development
< [Replizier- oder Speicherungskonfliki]

Result of comparison of fields ' X

Iv"“;" The subsequent fields contain varying values in the conflict or main document.
Fields with leading ""$" may be neglected.

OfficePhoneMumber: Conflict Value = (08677-9747-554)
OfficePhoneNumber. Parent Value = (0BE77-9747-577)

$REF: Conflict Value = (FD43FE7571553D91C1256B 73004888C1)
$REF: Parent Value = [No field of this name)

$Conlflict: Conflict Yalue = ()

$Conflict: Parent Value = [Mo field of this name]

Fig. 24: Replication conflicts

Subsequently, if the comparison of fields yields a relevant difference, the conflict and the main document will
be opened one on top of the other via the Conflict/Main Document button and the current field contents will
be overwritten by copy/paste (clipboard). The document updated in this way will be saved and the document
no longer required will be deleted.

If the conflict document contains the valid information, it will become the main document by clicking Convert
to main document. Please note that the previous main document should be deleted since otherwise two main
documents with identical ticket ID and almost identical content would exist. Only users with [&§R_MANAGER]
role are allowed to convert conflict documents into main documents.

You can prevent simultaneous editing of documents. Refer to Locking Documents in the HCL Notes Help.
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6.7.2 Messages

Program messages (green icon) e.g. on faulty configuration, missing documents and program errors (red
icon) are logged there.

6.8 ACL configuration

Users with manager rights can view all existing ACL entries of all HelpMatics™ modules via ADMINISTRATION
— ACL CONFIGURATION — ACL ENTRIES.

EB Open %*]New reading in of ACL ‘-’@ Easic settings

PersoniTeam/Server im Domino Directory Admin ServiceDesk |CMS Change Survey Knowledge |Poral Log
-Default- MNoAccess  MNoAccess  MNoAccess  NoAccess  Author No Access  No Access =
Administration fleces<IEIM - - - Morices - - - -
Admin - - - Manager - - - -
Alexander Banels/COC AG - Manager - Manager - - - -
Alfred Huber/COC AG Manager Manager Manager Manager Manager Manager - -
Processors Anna Auer/COC AG Manager Manager Manager Manager Manager - - -
g[ﬁ :I;:r Anonymous - - - Editor Author Author Author -
c ries Bernhard Aicher/COC AG - - - Manager - - - -
e Claudia MadliCOC AG Manager Manager Manager Manager Manager Manager Manager -
Categories DevelopmentiCOC Development Manager Manager Manager Manager - - - -
Templates Hans Zieglgaensberger/COC AG Manager Manager Manager Manager Manager Manager Manager -
Service level HelpMatics_1st-Level Reader Editor Editor - Depositor Editor Editor -
E-mail HelpMatics_1st_Level_Test = = = Editor = = = =
Clients HelpMatics_2nd-Level Reader Author Editor - Depositor Editor Editor -
Definition HelpMatics_Admin Manager Manager Manager o Manager Manager Manager -
Holiday HelpMatics_Admin_Test Manager Editor Editor Editor Editor Editor Editor -
Modules HM_WebTaskEditor - - - Depaositor - - - -
ACL Configuration LocalDomainAdmins Manager Manager Manager Manager Manager Manager Manager -
. LocalDomainServers Manager Manager Manager Manager Manager Manager Manager -
Michael MuellerlCOC AG Designer Designer Designer Designer Designer Designer Designer -
OtherDomainServers No Access  No Access = No Access = = No Access =
Peter Alexander Huber Meier/COC AG Manager Manager Editor Manager Manager Manager - -
rhenium/COC AG Manager Manager Manager Manager Manager - Manager -

Fig. 25: ACL configuration
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6.8.1 Basic settings

To ensure a correct display of the ACL configuration concerning a person/group/server, the roles existing in
the modules have to be read in first via the basic settings button. When the basic settings are opened for the
first time, the roles will be imported automatically. To guarantee a correct display, the respective basic
settings have later to be updated via the import roles from acl button.

qﬂcmse H save é% Import roles from ACL

Basic settings N
»

2

General data I

Path to Ad DB HelpMatics Clients
Senver: " thenium/COC AG CAT. COC; CCH. ITP
Path: " development\VB0\EN\hm_admin_e.nsf

ist of Helpmatics roles

"HelpMatics_Admin; HelpMatics_1st-Level; HelpMatics_2nd-Level, Change_Manager;
Task_Editor; Problem_Manager

*[&F_GLOBAL]: [&F_GLOBALADMIN]: [&F _QUICKDELETE]. [&F_READALL]: “[&F_DELTICKETS]; [8F_GLOBAL]: [&F_GLOBAL ADMIN]; [&F_QUICKDELETE]:

[&F_REPORTING], [&R_MANAGER]; [CAT], [CCH], [COC], [ITP], TTST]; [222] [8F_READALL]; [8F_REOPEN]. [&F_REPORTING]; [$R_1STLEVEL]; [&R_2NDLEVEL];
[8&R_2NDLEVELNEV], [&R_MANAGER], [&R_POLL], [8R_PROBLEMEDIT];
[8R_PROBLEMOWNER], [CAT; [CCH], [COCT, [ITP]. [TST]; [222] ,

A ACL roles - Change
" [&F_QUICKDELETE]; [&F_READALL]; [8F_REPORTING]; [&R_1STLEVEL]; “[8F_GLOBAL]; [&F_PROFILE], [&F _QUICKDELETE]; [&F_READALL]; [8F_REPORTING];

il ] i |
[&R_2NDLEVELNEW]: [RR_MANAGER]; [&R_PROBLEMOWNER]: [CAT]; [CCH]: [COC]: [TP]  [&R_TSTLEVEL]; [&R_CHANGEMNGR]; [8R_DEMANDCREATE]: [8R_MANAGER];
a [8R_PROBLEMOWNER]: [8R_TASKEDITOR]; [8R_WTASKEDITOR]; [ABC]: [CAT]; [CCH];

[COCT; [ITP]: [£22] 4

A roles - Knowledge
“[&F_READALL]: [&F_REPORTING]: [&R_CREATOR]: [&R_EXPERT]: [&R_KBMANAGER]: “[&F_READALL]; [&F_REPORTING]: [RR_MANAGER]: [&R_POLL] ;
[&R_MANAGERY]; [CAT], [CCH], [COC]. [ITP]. [TST], [£27]; [ Notes], [_Server], [_Support].

[_User]; [_Web] ,

Fig. 26: ACL configuration

6.8.2 Reload from ACL

By clicking the New reading in of acl button, the ACL entries of all HelpMatics™ databases will newly be read
in. A document will be created and/or updated for each person/group/server existing at least in one
database.
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6.8.3 Open ACL document

When you double-click an ACL document, or when you select the document and click the Open button, the
person's/group's/server's access rights to HelpMatics™ databases will be displayed.

ACL entry

Person, group, server in Domino Directory

Name: vsnotes1/COC AG User type: Server

ACL configuration depending on the module

I SeniceDesk | CMS | Change | Knowledge | Surveyl Portal | Log |

HelpMatics role ACL Access ACL roles

Manager [] [&F_READALL] ~
% [&F_REPORTING]
[&R_MANAGER]
it ¥ [&R_PROBLEMOWNER]
¥ Replicate or copy documents [ [AF]
[ [ASG]
[ [BGH]
[ [CAT]
[+ [CCH]
¥ [COC]
¥ [EAG]
M [ITP]
¥ [MUC]
¥ [STA]
¥ [T12] w

Fig. 27: ACL configuration
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7.1 Navigation W

Administration

By clicking Administration in the main navigator of HelpMatics™ ServiceDesk
you open the administration navigator.

Back
By clicking Back you return to the main menu.
Processors
Note: ll;ro:ess editor
You will get this selection only if you are granted the respective c; = foam
. tegories
rights. T
ype
Root cause
Categories
You can make all administrative settings for HelpMatics™ ServiceDesk there. mapletes=s
Service level
In addition to the administration of helpdesk team members, you can determine Ticket
the categorizations, create ticket templates for quickly recording frequently E-mail
recurring problems and make client settings there. Tool
Important: Clients
. . . . . Definition
Before using HelpMatics™ for the first time, you have to make some basic Holiday
settings that were dealt with in paragraph 3.2. Archiving
You will find menu entries not dealt with here in paragraph 6 ADMINISTRATION Portal
OF HELPMATICS™ - General. User portal
Service cockpit
Modules
Escalations
by ticket
by type of escalation
by recipient
Maintenance
E-Mail

Bulk changes
Replication conflicts
Messages

Help
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7.2 Categories

®" Root causes
To classify tickets by root cause, you have to create different root cause types here.

Root causes can be defined to be valid for all types or only for certain types. Thus, appropriately configured
root causes are available for certain ticket types only. If the ticket type changes, the root cause may be
removed and may have to be newly assigned.

Root cause

Name: " senice - unknown -
Configuration

Description: " Senvice for hardware, software or infrastructure Failure
Information

Valid for: " Alltypes Order

Type selection: "Incident 1 - First Fix, new; important Sonice

Incident 2 - Second Contact Fix e e

Incident 3 - Solution 2nd-Level
Problem 1 - Unknown Error
Problem 2 - Known error

Problem 3 - Request for change =]

Availability: "local ;i

Fig. 28: Type-root cause connection

7.3 Templates

7.3.1 Service level template

= Ticket monitoring
Ticket monitoring can be considered from two perspectives:

a) Monitoring of the agreed process times per client in relation to the user:
Process times agreed between the users of a client and the servicedesk. The target date will be
determined on the basis of the creation date of the ticket. Here, the service and process times of
the template stored in the corresponding client document will apply.

b) Monitoring of the agreed service times per process team in relation to the servicedesk:
Process times agreed between servicedesk and certain process teams. The process time will
start from the moment the ticket is passed on to the current process team. Here, the service and
process times of the template stored in the process team document will apply. Only in case a
certain process team cannot be clearly identified will the settings of the process editor document

apply.

So, service level templates can be defined for clients and for process editors/teams. In these templates,
service times, process times for different priorities and monitoring functions are stored. A service level
template will be assigned to each client. In the same way, a service level template can be assigned to each
process team and, if required, to each process editor. The monitoring relating to a process editor can be

COC AG HelpMatics™ Page 59 of 121



Administration of HelpMatics™ ServiceDesk

switched off in the process team or process editor document. Please note, however, that the settings of the
process editor document will only be effective if it isn't possible to clearly identify a process team. This may
be the case if a process editor hasn’t been assigned to any team or has been assigned to several teams.
Even then it may be possible to identify the process team if one of the teams assigned to the process editor
had been active as process team before the ticket was forwarded to him/her.

®=  Target time calculation

The process times planned for the different priorities are defined in the Process Time tab of the service level
template. They can be specified in minutes, hours or days. Holidays, times out of the service times (as
specified in the Service times tab) and On hold status periods are not regarded as process time.

Calculation if specified in minutes or hours:

The specified time is calculated on the basis of the start time and the available service times. If the start time
is before the start of service times, the start of service times of the start day will be used as start time. If the
start time is after the end of service times, the end of service times of the start day will be used as start time.

Calculation if Specified in days:

Whole days will be added to the start time. If time is not expressed as an integer, the rest time will be
calculated in minutes taking the average duration of service times into account, and will then be calculated
as if Specified in minutes. If, in case time is expressed as an integer, the calculated target time is a point in
time out of the service times, the start of service times or end of service times of the respective target day will
be set.

In the ticket — Responsibility tab -, the target time relating to the client is displayed in the responsible
person/team line, the target time relating to the process editor in the process editor / [process team] line
under Deadline.

= Automatic escalation

You can define three time stages in percent of the process time for which e-mail notifications are to be sent
when they are reached.

Every 15 minutes an agent checks all tickets the status of which isn’t closed (status not closed or return
status not processing completed (user informed)) or on hold if an escalation level has been exceeded and
sends escalation mails, if necessary. To initialize the sending of e-mails, the start date for escalation mails
must be set via ADMINISTRATION > MODULES > AGENT Settings. An e-mail will be sent only for tickets the
escalation of which is after this date. A log entry is made when an escalation e-mail is sent successfully. The
log entries relating to escalations with link to the ticket affected can now be viewed via the ADMINISTRATION >
ESCALATIONS menu.

Under ADMINISTRATION > MAINTENANCE > MESSAGES, you'll find messages on missing start dates, missing
service level template entries etc.
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= Example: Automatic Escalations:

The following diagram shows the escalations to be initiated for a ticket if both, for the client and the process
teams A and B, escalation levels have been defined at 25%, 50% and 75%:

Creation of ticket Monitoring event/e-mail notification Target time SLA/Client
SLA Monitor | [Ticket period T [ 1]
(Client)

Process time group A 1 |¢— Target time OLA/Group A Ticket closed
OLA Menitor
(Process editor) || Forward to group A Process time group B [1 [] |
Forward to group B Back to process owner/
Time axis Target time OLA/Group B

|:| Ticket period (total)
|:| Processing group A

|:| Processing group B
|:| Threshelds / Monitering events with e-mail notification

Fig. 29: Example of automatic escalation

The escalation level for process team A was not reached in this example since the ticket had been forwarded
to process team B before.

= Special case: ON HOLD status

If a ticket is set to ON HOLD, calculated processing targets will be ineffective until the status is set to work in
progress or assigned external again. A new target date will then be calculated, taking the on hold period into
account.

= Calculation of lead time and response time

The lead time is calculated for tickets created via Mail-In. It is calculated from the time of receipt in the mail-in
and the time of ticket creation, taking the service times into account. The lead time is shown in the Reporting
in an overview, categorized by ticket source and time grid.

The Response time is calculated from the time of creation of a ticket ( open status) and the time of first
editing of a ticket by the assigned process editor ( on hold status), taking the service times into account.
When the ticket is edited for the first time, the status will, however, be set to work in progress if the logged in
user is also process editor of the ticket. In the Reporting, the response time is specified as average value
sorted by maximum value.

= Creation of service level templates

There are 2 types of service level templates:

- service level templates that are assigned to clients,

- service level templates that can be assigned to process editors or process teams.

You decide which one to create by clicking the SERVICE LEVEL — NEW > FOR CLIENTS button or SERVICE LEVEL —
NEW > FOR PROCESS EDITORS button.
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= Design of the service level templates:
Tab 1 - Definition
In this tab you enter the name of the template. Moreover, you can enter a brief description.

Tab 2 — Service Times
The service times are taken into account when calculating the target date for closing the ticket.

The specification of the time zone allows correct calculations also in global support structures. Please bear in
mind that the (de)activation of daylight saving time in the Service Times tab will not be carried out
automatically. In case of a wrong setting, target time calculations may differ up to one hour, e.g. when, if
daylight saving time is activated in winter, a ticket target time falls up to 59 minutes before the service time
ends.

Tab 3 — Process time
On the basis of the process time, which can vary for the different priorities, a target date will be determined.

In the definition of the process times, there are differences between service level templates for clients and
service level templates for process editors:

Service level template for clients

Service Level for clients

Definition ] Senice times ] Process time \ Maonitoring ] Hierarchical escalation ]

" Base configuration
f+ Advanced configuration

Incident | Service Request | Problem

Name Process time Unit
& T " Minutes ¢ Hour(s) ¢ Day(s)
4+ Thigh, "30, & Minutes ¢ Hour(s) ¢ Day(s)
-+ 7 " " Minutes © Hour(s) ¢ Day(s)
= "standard "8, © Minutes & Hour(s) ¢ Day(s)
+ Tlow, "5, = Minutes © Hour(s) & Day(s)

Fig. 30: Service level template for clients

Description and Process time can be specified in minutes, hours or days for one to five different priorities. A
value must be stored for the standard process time (**).

Via Advanced configuration you can define different process times for the ticket types Incident, Service
Request and Problem. You enter these types under ticket types.
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In the Service Level Template for Process Editors, you can choose between absolute process time and
process time as defined for the client:

Definition I Service times | Process time l hlanitoring |
# Ahsolute
= Proportionally (to client)
Process time Unit
& (Priority 1) "B0 & Minutes € Hour(s) © Dayis)
4+ (Priority 2) "2 ¢ Minutes & Hour(s) ¢ Dayis)
= (Priority 3) '3,  Minutes @& Hourfs) © Day(s)
= (Priarity 4) "5,  Minutes & Hour(s) € Dayis)
+ (Priority 5) T ' Minutes € Hour(s) & Dayis)

Fig. 31: Service level template for process editors - absolute

The description of priority cannot be defined as it is client-dependent. For a ticket, you can choose from the
priorities defined for the corresponding client. The priority of the ticket is used for determining the available
process time of the current process team. Therefore, a process time should be defined for every possible
priority (1-5).

Alternatively, reference can be made to the process times defined for the client of the ticket when defining
the process time for process editors: In the example (see Fig. 32 ) the same process times as those for the
client apply.

Important: The basis for calculating the client-related target date is the ticket creation date, whereas the
target date for process editor monitoring is determined on the basis of the date of forwarding the ticket to the
process team.
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E:gi Schlielien H Speichern

Service Level (fur Bearbelter)

Definition | Sericezeiten | Bearbeitungszeit I anitaring |

Bearbeitungszeit

Bearbeitungszeit mandantenbezogen

& (Prioritat 1) 100, %
4+ (Prioritat 2) 100, %
<+ (Prioritat 3) 100, %
= (Prioritat 4) 100, %
¥ (Prioritat 5) T100 4 %

Fig. 32: Service level template for process editors - proportionally (to client)

Tab 4 — Monitoring
Automatic actions are specified in three levels there.

So you can choose a mail template there which is to be used when a ticket has reached the specified
escalation level and an e-mail is to be sent to the persons concerned.

In addition, you can define names for the escalation levels (these will appear in the monitoring view) and
enter percent values for the individual levels.

Recommendation: Adopt the default names for the escalation levels as the sorting in the monitoring views
can be affected thereby.
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Definition | Service times | Process time | tonitoring I Hierarchical escalatinn'

Monitoring (automatic)

E-mail template: T
I J Q}Display
Mame Elapsed time in percent of Automatic notification
process time
Level 3: r2EIDJ % [T E-mail to following recipients __| rJ

r g
Escalation level 3 :
. ¥ E-mail to process owner

¥ E-mail to process editor

Level 2: 7100, % [T E-mail to following recipients __| i

F .
Escalation level 2 .
. ¥ E-mail to process owner

¥ E-mail to process editor

Lewvel 1: 75, % [T E-mail to following recipients __| T

r g
Escalation lewel 1 :
[ E-mail to process owner

¥ E-mail to process editor

Fig. 33: Service Level for Clients

Tab 5 — Hierarchical escalation

In contrast to automatic escalation, hierarchical escalation is to be carried out manually in one of the
monitoring views. Here you can define which e-mail template is to be used and who is usually to be
addressed when the respective level has been reached. These settings are client-specific, i.e. they can only
be made in the service level template for clients.
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7.3.2 Ticket templates

@ Open Ticket Template - New '-;F'rim

Name ~ Description Main category -~ |Sub-category 1 Sub-category 2 Template-Selection Client
¥ COC Germany AG
* according to main category
* Client Application
SAP GLI Configuration SAP GUI Client Application  SAP GUI Main category COC Germ
¥ SAP I/\\)
Access SAP Ri3 SAP R/3 access required SAP Basic Main category COC Germ
SAP FICO: Transaktion PESE Error at execution of PESE SAP FliCO Main category COC Germ
SAP MM: Transaktion VAO4 Error at execution of VAD4 SAP MM Main category COC Germ
 Portal
Access Lotus Notes Access to Lotus Notes required Security & Administri User Administration Lotus Notes Portal COC Germ
Calendar functions not available Calendar functions not available Client Application ~ MS Outlook Portal COC Germ
Print Job Error Print Job Error Server Application  Windows Print Servi Portal COC Germ
Proxy Server Settings Taking over current settings Security & Administr: Proxy Server Portal COC Germ
= Standard
Access Lotus Notes Access to Lotus Notes required Security & Administri User Administration Lotus Notes Basis COC Germ
Central component breakdown Central component breakdown Network Infrastructun Data Link Basis COC Germ
Printer maintenance Tener applyment Client Hardware Printer Local Basis COC Germ
SAP SAP Basis COC Germ
Virus alert Virus alert Client Application  Trend Micro Basis COC Germ
b COC Switzerland AG
P IT Pride
» [not assigned]

Fig. 34: Ticket templates facilitating ticket recording

Templates make ticket recording a lot easier since all relevant data is filled in automatically.

Under TEMPLATES > TICKET you can see all ticket templates which the helpdesk team members can use to
quickly and easily fill in a ticket.

With the Ticket Template - New button you can add a new template. Here you can define all fields which
would otherwise have to be filled in individually in the rapid recording window. This template can then be
selected in the rapid recording window.

You control the availability of the template in the rapid recorder via the Client and Template selection
properties. Ticket templates with Client property are only available in tickets of the corresponding client.

If template selection is set to by main category, subcategory 1 or subcategory 2, the template will only be
available after you have set the respective category in the rapid recorder, whereas ticket templates with
Basic setting will be offered as long as no category has been selected in the rapid recorder. This property
allows you to define a multi-level template selection, a decision tree: Create several basic templates whose
categorization determines the next level of the templates available.
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Templates with Portal setting are only available in the user portal. Additional settings such as

- Name of the responsible person/team
- priority of the newly created ticket
- description (tool tip to to facilitate ticket selection for the user)

are required.

Ticket Template

General data I Ticket | Partal I

Available in portal: "HelpMatics-Support (German)
HelpMatics Support (English) =]

Responsible person/team: [Hardwaresupport]
Priarity: = 1 (highest priority)
2
3
v 4

= 5 {lowest priority)

Description: "Use this template if the printer isn't working.

Fig. 35: Configuration of ticket templates for the Self-Service Portal

7.3.3 Tool templates

Create new tool templates to allow HelpMatics™ process editors to start other programs directly from the
ticket.

This can be combined with any field values from the ticket (also refer to the Template Info button in the tool
document).

Thus it is possible e.g. to directly transfer the IP address to the remote tool called. Of course, simple calls
such as ping or tracert are possible as well.
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7.4 Clients

7.4.1 Import
c(ﬁCIose HSave iA_)FieId-Deﬁnilion

General data
Name: " Development Server: " CN=domino/0=COC AG ,
Type: & Notes Organisational unit: ¥ %
Client: "IT Garant =1 Organisation: Bl

—— T e.0. Julia Hertz/Dev/COC-AG: the entry "Dev" refers to the organisational unit, the entry “COC-AG" to the
Description: organisation

of the Domino Directory:

Search string in the specified field: "D@\U

Fig. 36: Import from Notes Name and Address Book (NAB)

The Import can be configured to be lient-specific.
You can filter field-specifically from the Domino directory.

For a user import in HelpMatics™ ServiceDesk the contents of the following fields are transferred from the
NAB by default:

LASTNAME, FIRSTNAME, OFFICEPHONENUMBER, CELLPHONENUMBER, OFFICEFAXPHONENUMBER, DEPARTMENT,
LOCATION, SHORTNAME, EMPLOYEEID AND MAILADDRESS.

Only documents where the field contents of the source DB deviate from those of the target DB (HelpMatics ™
ServiceDesk) will be imported or overwritten on field level. This guarantees minimization of replications. In
case of automatic import, documents (user data) should not be changed in HelpMatics™ since the field
contents could otherwise be overwritten.
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7.4.2 Archiving

HelpMatics™ ServiceDesk requires extended archiving settings. These are defined under "Archiving". Only
closed tickets will be moved.

lﬁcwse HSave

eSS
Archiving \ﬁ \\\ /

General data Cmiﬁguratidn
Name: " Archiving First archiving: 13.04.2006 18]
Client: |COC Germany AG ;] Period: IEVQW Manth vl
Tickets, closed since f3EI_, days.
Archive database: s
Server: CN=tunefishiO=COC AG
* Has to be on the same server as the active database. Specifiy only path and filename.
Description:
g

|

Fig. 37: Archiving settings for closed tickets

7.5 Modules

Important for defining the basic configuration of HelpMatics™ ServiceDesk. Links to other modules
(Knowledge, Survey, Change) and further settings for HelpMatics™ ServiceDesk are specified there. In the
Agents tab the server name for periodically running agents is set.

Please note that these settings are server-specific, i.e. this item is to be edited for each server also in case of
cluster operation.

7.6 Maintenance

= Delivery reports
In this view, all e-mails that cannot be delivered when sent from HelpMatics™ are displayed.
=  Bulk changes

By using this function you can change any field value of existing tickets (when called from the ServiceDesk
module) and resources (when called from the Configuration Management module).

Enter the old field content to be replaced as well as the new field content.

Select the field to be changed from the dropdown list and specify further criteria. Determine under execution
if the change is to be made immediately after Activation. If a date is specified, a periodical agent will execute
the change when due.

Please note:
This function updates all tickets/resources concerned. This may take some time or, in case of parallel

processing, lead to storage and replication conflicts. For this reason a scheduled execution is
recommended.
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7.7 Automatic e-mail processing

A periodical agent monitors the Mail-In area of HelpMatics™ and filters the e-mails showing a ticket ID in the
subject. The e-mail will be attached to the ticket, the process editor will be informed and a flag = will be set.

The following configurations are necessary:
- Mail-In Mang\ement must be activated for‘each client:

General data | SeniceDesk |

E-mail to User? [~ Yes

E-mail template: [

Cloéihg of incident

Creation of incident

E-mail to User? [~ Yes

E-mail template: [

Méil'-lhnin'énagéméh‘t“

E-mail assignment:

v §attach to tickets automatically§

Fig. 38: Mail-In Management

- At database level of the HelpMatics™ ServiceDesk database, Document locking must be activated.

¥ Allow document locking

- For the process editor/process team to be informed, e-mail notification when a ticket is assigned has to

be activated for the process editor/process team.

Please note:

- The ticket ID must be included in the subject of the e-mail.
- Closed tickets will not be taken into account by the agent.
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7.8 Reporting

7.8.1 Reporting views

Concerning ticket selection, the reports are subdivided into the areas Incident and Problem . As in most
cases Reporting is adapted to the customer’s requirements, only an example of a report is shown below. By
clicking the Report info button in the reporting views of HelpMatics™, you will get more detailed information.

Example: Incident > Overall reports > Category:
In this view you can see all incident tickets that have been created — subdivided into client and the three
category levels (main category, subcategory 1 & 2). If necessary, the time distribution can also be viewed

there.

Repotting
Back

Incident

Daily reports
Category
Type
Create time
Process time

Monthly reports
Category
Type
Root cause
Nant 1icar

05.09.2018 14:49 Problem Exchange Server down

%)Reponinfo Problem bPrint';

Fig. 39: Incident — Overall reports — Category

COC AG

HelpMatics™

| |Total  in% Brief description
» COC Austria AG 55 5.6%
¥ COC Germany AG 868 89.1%
¥ 2018 809 93.2%
~ September 49 81%
b Client Application 1 2.0%
» Client Hardware 6 12.2%
» Client Operating System 5 10.2%
» Network Infrastructure 5 10.2%
b SAP 13 26,5%
» Security & Administration 11 22.4%
» Server Application 4 8.2%
» Server Operating System 4 8.2%
» August 120 14.8%
R ane S
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7.8.2 Graphical reports

This area permits a direct graphical representation of the ticket data within HelpMatics™. You can store
reports to be reused and display the results as bar, pie or line chart.

The data is prepared at night, which optimizes the speed of the graphical representation. Although it is
possible to immediately activate refreshing by clicking the Reload data button, this is only recommended in
times of low server workload.

ﬁClose HSave %Use zettings %Reload data .-léFiltervalidation %}Repor‘tinfo
| -lllu.,_

Graphical report 'g" a

General data

Mame " Report 2006
Description ¥
Typ [ Quartal
140
170 1 == B Problem_-_2_Known_errar
100 +— Olncident_-_4_Secand-
Level_fix_f_resolvakle
L — — Olncident_-_3_Second-
g0 L Level_fix
— M Incident_-_2_fixed_later
40 +—
OlIncident_-_1_first_fix
20 —
0 T T T
|.2004 112004 IIl.2004 Iv.2004
Settings
Chart type ISum bar 20 j [T in mesw window
Evaluation ITWJE j
Clients [ COC_Germary_AG

Period [01.01.2004 s8] pi0[21.12.2004 1]  Interval |@uaner -]

Filter formula T ( empty = without fitter)

Data setfrom: 13.04.2006 06:02

Fig. 40: Graphical representation of the overall report
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How to create a new report

1. Click Report — New in the action bar of the view.
Now you can enter name and description of the report. In the Settings area you can enter a filter formula
to further restrict the selection of the tickets. For advice concerning the syntax, please refer to the HCL
Notes Help under Refining a search query using operators. You can have your formula checked for
correct syntax by clicking the Filter validation button.

Some examples of valid formulae:

Field MailAddress = servicedesk@coc.ag.com

Field RespDepartment = Helpdesk

Field ProFullName Contains Huber , Maria AND Field RespDepartment Contains Helpdesk

You will find a selection of available field names by clicking the Report info button.

Please note: When you are using a filter formula, this filter must not return more than 5,000 documents.

Reason: By default, the maximum number of documents allowed for a full text index is 5,000, which can
be extended to 15,000 documents.

Restrict the filter so that the number of documents returned will be below the limit. You can check the
filter for the number of results e.g. in the Tickets/User view.

2. Inorder to load the prepared data, click Reload data. You can retrieve the last saved data set or request
immediate refreshing. The new report will be saved and closed automatically.

3. Select the new report from the view and open it. Now you can make further settings:

= Choice between different chart types

=  OQutput directly in Excel via the in separate window checkbox. Otherwise embedded in the
report.

= Select the client(s) you want to evaluate.

= From the Evaluation list select a category you want to evaluate and specify the evaluation period
and interval.

4. By clicking the Apply settings button the data will be represented in the form of the selected chart type.

5. After clicking Save the settings made will be kept for further use.
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7.8.3 BI/ Data export

These views display all tickets together with the most important data.

i:/,e'Repnrtinfn @Expurt(csu} @Excel Export
Ticket 1D Created on |Brief description Main category  |Sub-category 1
[ReferenceMumber] |[CreateDate] [ProblemShort] [MainCategory] [SubCategory]

OC-121271409097159-Dvl 14122012 Failure of 2 main compe MNetwork Infrastruct Data Link
COC21214051040-Dl 14122012 Failure of @ main compe Metwork Infrastruct Data Link

Fig. 41: Ticket view for data export

By clicking the EXPORT (CsV) button you can export the data as csv file.

Depending on the configuration under MODULES-> INTEGRATION, the Excel Export button will additionally be
displayed.

By means of the Excel Export button, the data — for any selected client and period — can be exported directly
to an Excel file. If you have selected several documents in the view before, these will be exported. If not, the
criteria to be used will be queried in a dialog box.
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The following views are available, particularly for access via ODBC:

a) Ticket data (export): General ticket data

Name:
Alias:
Selection;
Access:

Use:

Reporting\BI\Basic Ticket Data
Bl_BasicTicketData

all Incident and Problem tickets

[&F REPORTING] role is necessary

This view can be used for analyzing general ticket data. It is not suitable for analyzing
the processor history or group assignment. For this, separate views are available.

b) Group assignment

Name:
Alias:
Selection:
Access:

Use:

Reporting\BI\Group Assignment
Bl_GroupAssignment

all Incident and Problem tickets
[&F_REPORTING] role is necessary

This view can be used for analyzing group assignments within a ticket. Within the
view, a separate entry is maintained for each group. The values of the ProGrpName
field are analyzed for this. The ticket ID (ReferenceNumber) is used for linking tickets.
In the ProGrpStart and ProGrpEnd fields, start and end of the assignment to the
respective group are logged as date-time-value. In the ProGrpEscLevel field, the
escalation status of the ticket at the end of group processing is logged.

c) Processor list

Name:
Alias:
Selection:
Access:

Use:

Reporting\BI\Processor History
Bl_ProcessorHistory

all Incident and Problem tickets
[&F_REPORTING] role is necessary

This view is used for analyzing the process editors/process teams involved in a ticket.
A separate entry is maintained within the view for each entry in the processor history.
The values of the ProFullName multi-field are analyzed for this. The forwarding date
is specified in the ProDate field (field name “assigned”). The ticket ID
(ReferenceNumber) is used for linking tickets.

d) Linked Tickets

Name:
Alias:
Selection:
Access:

Use:

COC AG

Reporting\BI\Linked tickets

BI_LinkedTickets

all Incident and Problem tickets that contain ticket links
[&F_REPORTING] role is necessary

This view can be used for analyzing links between tickets. A separate entry is
maintained within the view for each entry in the Tickets tab. The ticket ID (Reference
or Referencenumber_linked) is used for linking tickets.
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e) Linked ClIs
Name: Reporting\BI\Linked Cls
Alias: Bl_LinkedTickets
Selection: all Incident and Problem tickets that contain ClI links
Access: [&F REPORTING] role is necessary
Use: This view can be used for analyzing links between tickets and Cls. A separate

entry is maintained within the view for each entry in the Linked Cls tab. The ticket
ID (Reference) is used for linking tickets and Cls.

7.8.4 Ticket monitoring in the service cockpit 2.0

The service cockpit offers an option to show the current ticket number status

- team overview of tickets

- tickets created today

- tickets of the current and the previous month

tickets not closed for a long term

filtered according to the department of the responsible person’s and ticket client. The display is automatically
refreshed, web-based and so suited for various end devices.

Exemplary link:
https://<ServerName>/<Path>/<ITSMDatabase>/xServiceCockpit.xsp?companyname=<Client>&respdepart
ment=<Department>

The parameters companyname (name of the client: Field CompanyName in ticket) and respdepartment
(Department of the responsible person’s: Field RespDepartment in Ticket) are optional.

Note:

This requires that the department is consistently maintained in the process editor and process team
documents. Changes of the department name will affect this display.
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HELPMATICS SERVICE COCKPIT Last updated: 15.10.18 16:39

>Team overview >Today >Current month
Application Service 1 Incidents: 0 Created: 19
B 4 0
Communication | Service Requests: 0 Closed: 2
B P P . .
Hardwaresupport 1 Problems: 0 Immediate resolution: 1 (50%)
o : 5 . s 0 . ion- 0
Infrastructure i Changes: 2 1st level solution: 0 (0%)
B P w
R N All fickets and changes craated foday. Independent of the current Tickets of of the current month (from 1st until today).
Operative Service m— I tickst status. Created: Number of created ticksts.
o 2 0 Closed: Number of closed tickets (status closed or ‘closed/user
Problem Management 1 informe).
o N ' . A B " Immediate solution: Number and % of tickets closed on first call.
st level solution: Number and % of tickets resolved within a
SAP Basis Services mumm— 1 i —
[ . w
Security m— — 1
o F W
Service Desk 1 >Long running tickets >Previous menth
] w
User Administration mes 1 > 30 days: 37 Created: 58
o :oh ks 6 W
10-30days: 0 Closed: 95
Active lickets per process editor team
The bars are allocated according fo status (red = open, yellow = in work/external, violet = on hold). . : P a,
The gray background represents the escalated fickets of fhe respeciive status 3-10 days. 18 Immediate resolution: 24 (25 A’)
The limit is represented as verfical black line. When the limit is exceeded, the color of the team name will change to red < 3 dEyS O 1 St ‘evel Solutlon 22 (230‘/ )
. . 0
Period in days from ficket creation uniil foday: Tickels of Previous months (total month)
Considers all acfive tickets. Created: Number of created tickets
Closed: Number of closed tickets (status closed or ‘closed/user
informed’)

Immediate solution: Number and % of fickets closed on first call
st level salution: Number and % of ticksts resolved within a
depariment

Figure 42: Ticket overview for COC department, COC AG client

You find explanations regarding the represented values at the end of each chart.

For the team overview chart, you have to define the limits for tickets in the process team document for the
service cockpit display. If the number of tickets processed by the team exceeds the limit, the process team’s
color will change to red. The limit itself is represented as vertical black line.

The scaling is based on the highest limit value of all process teams.

7.9 HelpMatics™ Widgets

7.9.1 System requirements

When HelpMatics™ is used with HCL Notes 8.5.1 Standard, different widgets are available. These can be
deployed using the known HCL Notes deployment methods (update site and widget catalog instructions).

7.9.2 HelpMatics™ One-Click Ticket

HelpMatics™ One-Click Ticket is only available when the ServiceDesk database is open.
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7.9.3 HelpMatics™ FastText
HelpMatics™ FastText is available whether or not the ServiceDesk database is open.

7.9.3.1 Configuration
Configuration is set via the user preferences of the Notes client.
Enter the path to the HelpMatics™ Admin database where the text modules are managed.

=

| tvpe Filker text HelpMatics FastText S s D
- Accounts )
- Basic Mokes Client Configuratior HM Admin Server I wsnokes1COC AG
(- Calendar and To Do Hr Admin Path | apps/helpmatics hm_adrin, nsf]
[+ Composite Application Editar
- iZontacks

- Fonks and Colors
- HelpMatics FastText
- HelpMatics Mail-In Monitor

Fig. 43: Configuration of HelpMatics™ FastText

Process editors that are assigned the [&R_Manager] role in the Admin database can create publicly available
text modules. These modules cannot be changed by process editors to whom this role has not been
assigned.

Private text modules can be created by everyone. The entries are managed and updated via the menu or
context menu. The individual text modules will be categorized according to the respective HelpMatics™
modules (ServiceDesk, Change, ...).

7.9.4 HelpMatics™ Mail-In Monitor

Preferably this widget should be installed by persons monitoring the HelpMatics™ Mail-In area. The Mail-In
Monitor visualizes the HelpMatics™ Mail-In area and informs the user about incoming e-mails. This widget is
available whether or not the ServiceDesk database is open.

7.9.4.1 Configuration

Configuration is set via the user preferences of the Notes client.

You can define there if a popup shall appear when a new mail is received. Server and Path must be
configured. The Monitoring interval is specified in minutes and determines how often the Mail-In area will be
monitored for new e-mails.

=

[ type Fiter text HelpMatics Mail-In Monitor P
.ﬁ.ccfjunts ) . . v Popup Matification
- Basic Motes Client Configuratior

- Calendar and To Do Database Server I venokes 1 fCOC AG

[+ Composite Application Editor
- Contacks

- Fonks and Calors Interval | 15
- HelpMatics FastText

- HelpMatics Mail-In Monitor

Database Path | apps/helpratics/hm_servicedesk, nsf

Fig. 44: HelpMatics™ Mail-In Monitor configuration
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8 Administration of HelpMatics™ Knowledge

8.1 Prerequisites

Storage of the knowledge database on a HCL Domino server and full text indexing of the database are
required for optimum functioning.

You will find menu entries not dealt with here in paragraph 6 Administration of HelpMatics™ - General.

8.2 Accessrights

Access rights and configuration of the process editor documents are described in more detail in chapter 3.3.

8.3 FAQ categories

In order to categorize FAQ documents you can either use the categories created under ServiceDesk (see
6.3) or create your own categories here. Please note that FAQ categories always have one subcategory
only.

8.4 Client

By double-clicking a client in the list you can edit his profile and provide it with an e-mail address (Notes-Info
tab).
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8.5 Configuration

Here you will find the basic HelpMatics™ Knowledge configuration. Please note that these settings are
server-specific, i.e. this item is to be edited on each server also in case of cluster operation.

sigciose [ save

..Conﬁguration

Settings l

Automatically assign experts to new documents: [~ Yes

Click ™es" if new documents shall be automatically assigned to an expert because of their categorization.

Bypass the editorial workflow:

Click ™'es" if new documents shall be released immediately (without processing).

___but observe restriction to clients: I~ Yes

Click ™v'es” if the access to documents shall be restricted to their original client.

Take over FAQ categories: ™ Yes

Click ™es" if you wish main category and sub-category 1 to be imported for FAQ categorization.

Lowest relevance level - 0,
Enter a figure for the relevance factor from which on a document is provided with one star.

Highest relevance level : 100,
Enter a figure for the relevance factor from which on a document is provided with the maximum number of stars .

Influence of the release date: "0y
Enter a value by which the relevance factor of a document decreases per day as from the date of release.

Fig. 45: Basic HelpMaticsTM Knowledge configuration

8.5.1 Automatic assignment of experts

Please activate this option if an expert shall be assigned to new Knowledge documents automatically (agent
running at night).

An expert or an expert group can be entered in the categories/subcategories as default value. If an expert is
preset for the lowest categorization level of a document, this expert will be transferred; otherwise, the expert
of the next higher level will be transferred and so on.

This agent can also be used for selected documents from the menu.

8.5.2 Bypass the editorial workflow

Please activate this option if the editorial workflow shall be bypassed: Release of all Knowledge documents
without editorial preparation for all user groups.

8.5.3 ...but observe restrictions to clients
Please activate this option if multi-client capability is to be maintained in spite of bypassing the editorial
workflow.

8.5.4 Take over FAQ categories

Please activate this option if the FAQ categories (main category and first subcategory) shall be imported for
the FAQ categorization (at night).

Additional manually created entries will be marked with an X in the man. column.
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8.5.5 Lowest relevance level

Enter a figure from which on the document is to be provided with one star * . The number refers to the
relevance factor of a document. The relevance factor is calculated from read count, use count and up-to-
dateness.

8.5.6 Highest relevance level

Enter a figure for the relevance factor from which on the documents are provided with the maximum number
of stars.

8.5.7 Influence of the release date
Enter a value by which the relevance factor of a document decreases per day as from the date of release.
Relevance factor points are assigned in the following way:

e 1 point per call in the Notes client (solution, FAQ)

e 6 points per use in the Notes client (solution, FAQ)

e 1 point per call in the Web client (FAQ)

e 4 points per positive rating in the Web client (FAQ)

e 2 points deduction per negative rating in the Web client (FAQ)

8.6 Reporting

Only knowledge managers have access to knowledge reporting. The following views are available:

View Description

Use This view gives an overview of the frequency of use of the individual
knowledge documents.

= Read count: How often has the document been opened since its
release?

= Use count: How often has the document been used for a solution of a
request in HelpMatics™ ServiceDesk since its release? (also see the
outline relating to relevance)

= Last access: When was the last user access (read or use)?
Release This view displays the user groups for which the knowledge documents

have been released. If a document has been released for more than one
group, it is found under each of these groups.

Portal This view gives an overview of the frequency of use of the FAQ documents
in the user portal. The following properties relate to portal access:
= Read: How often has the document been opened since its release?
= Pos.: How often has the document been rated positively?
= Neg.: How often has the document been rated negatively?
= Access: When was the last user access to the portal?
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9 Administration of HelpMatics™ Change

9.1 Prerequisites

The optimal use of the search function requires full text indexing of the
database.

The Allow locking documents database property must be activated.

9.2 Accessrights

In chapter 3.4 the HelpMatics™ Change settings and rights are described. Administration
. . Back
9.3 Navigation
By clicking Administration in the main navigator of HelpMatics™ Change you Processors
open the administration navigator. Process editors
Process teams
By clicking BACK you return to the main menu. Type
Note Category
. . . . . . Validation
Yo Il get this selection only if you are granted the respective rights.
u will g i i y if you g pective rig Tohoton
RFC
You can make all administrative settings for HelpMatics™ Change there. Change
. . . . Release
Apart from the administration of the process editors you can specify Task
categorizations, provide templates for web requests, RFCs and Changes as A
- Service level
well as print templates. 2
E-Mail
Portal
You will find menu entries not dealt with here in paragraph 6 Administration of User portal
HelpMatics™ - General. Web request
Clients
Definition
Holiday
Archiving
Modules
Maintenance

Replication conflicts
Invalid templates
Messages
Deletions

Help
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9.4 Categories

= Validation

Specify the values to be available for the RFC or Change checkboxes (priority, consequences, risk, business
relevance and urgency) and in the Task (type, rating criteria) here.

Enter the individual values, separated by vertical spacing.

As concerns priority, please note that for the first three values of the list the icons are assigned in the order
high, normal, low (see chapter 5.3). An icon is not assigned for values that might follow.

The fields of impact, risk, business relevance and urgency can be mandatory fields, optional fields or be
hidden.

Concerning the rating criteria, a value can be defined for cancelation of workflow (e.g. Not ok) and several
values for continuation of workflow.

COC AG HelpMatics™ Page 83 of 121



Administration of HelpMatics™ Change m

9.5 Templates

9.5.1 Web request form

Create a web request form to enable the user to request RFCs via a web form.
With the weB REQUEST FORM - NEW button you can add a new web request form.
Double-click on a web request form in the list to edit it.

The web link will automatically be generated and can be made available to any user for entering ideas and
change requests. Among others, the change manager to be notified, field descriptions and mandatory fields
are defined in the web form.

It is possible to create an attachment. It should be pointed out that several files can be attached as a ZIP file.
Mandatory fields are colored in the web form.

d{icwse H Save I %Insen graphlc | @ Responsible person | e Copy Web link | g)lnformatlon on web request

Web request form 7 o

General data] Requesterl Form ﬁeIdI Description fields I Costs ] Mail templates]

Name: “Welcome at Useradministration
Client: ‘coc Germany AG ;=]
Titel: “Welcome at Useradministration
Brief description: " create new user

[~ HTML
Description: i

[© HTML

Labeling [Description]: “Description
Graphic (JPG, GIF, PNG):

hmlogopng  ; & showabove ¢ show left

Use a graphics with an aspect ratio where the width is significantly bigger than the height (recommendation: 1000 x 200 px).

Responsible person:

Available in Portal:

Urlaub , Farin -

“New EN Portal ;=

v Automatic creation of standard change

Change template:

Labeling
[Optional Tasks]:

“ladministration: New Employee ;=1

" optional tasks

[V Filter regarding user departments

Departments:

" ServiceCenter
Remark: Separate the values with ; (semicolon)

Fig. 46: Web request form
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General tab
Apart from general definitions you store the basic configuration settings here.

- You indicate the Change Manager as responsible person.

- The web request form must be integrated into a HelpMatics™ portal. For configuration of the user portal,
proceed as described in chapt. 6.6.1 .
The web request form can be called within a user portal or directly be addressed via the Solo links.
You find the Solo links in the portal definition of the user portal or under Administration-Portal-Web
request in HelpMatics™ Change.

- In addition you can determine whether a standard change is to be created when a web request is sent.
In this case the user is offered optional tasks in the web request form in addition.

- If the restriction to user departments is activated, only logged-on users of this department will see this
web request in the web portal.

Requester

Define which of the requester's data shall be visible in the web request and if this data should be
changeable.

Determine which of the requester’s or reporter’s data is to be visible in the request and if this input is to be
mandatory. A distinction between requester and reporter data is only made if the REQUESTER = REPORTER
(texts can be configured) option is deactivated in the request. In this case the reporter is the user who is
logged in when the request is filled in. If the ALLOW MANUAL INPUT OF REQUESTER DATA BY REPORTER option is
deactivated, the requester has to be set and selected in a dialog.

Form field tab
In the form field tab 15 user configurable fields are available.
Description fields, Costs, Mail templates tab

The following tabs provide other fields. In addition you can store e-mail templates for sending confirmation
notifications.

9.5.2 RFC, Change and Release

9.5.2.1 General information
In addition to name and brief description, you can add to the template as many pieces of information and
tasks as you want in order to characterize recurring RFC/Change or Release types in more detail.
Based on an available template you can quickly define a similar workflow via the copy function.

9.5.2.2 Special information on Change templates
Change templates can be categorized into standard changes, normal changes and emergency changes.

A Change template can be characterized as Standard Change, i.e. as frequently recurring Change with a
predefined procedure. For this Change type the “Autoclose” function can be activated. When all tasks are
completed, this Change will automatically be closed.

Standard changes can be initiated by 1st level team members and will immediately obtain the Processing
Active status. (Please note: This role must be assigned to the user in the access control list of the Change
module and, if necessary, also in the ServiceDesk module).

= Specification of a carrier ticket template:
If a Standard Change is created in HelpMatics™ ServiceDesk from the Resources — User or Resources
— Config. item view, a carrier ticket will automatically be created for this Change in HelpMatics ™
ServiceDesk under the following conditions:
o only 1 document is selected in the view (a user or configuration item document).
o acarrier ticket template is stored in the Change template selected for the Change creation.

The carrier ticket will be created in the background when the new, saved Change is closed.

COC AG HelpMatics™ Page 85 of 121



Administration of HelpMatics™ Change

= QOptional tasks in Change templates:
The setting specifying if the task is optional for the Change can be modified for the individual tasks.
Select one of the following properties:
- REGULAR TASK: a task that cannot be used optionally.
- OPTIONAL TASK: the task is offered as optional task for creating the change.
- DEPENDING ON: Select a task here. Select from optional tasks. If a change is created on the basis of a
template and an optional task is used, all tasks depending on this task will be inserted as well.
In the change template the tasks are marked by a ? (blue) character for optional tasks and ? (gray) for
dependent tasks.
Please note: When you set an optional task to “regular”, you might have to edit dependent tasks
manually and, if applicable, newly define the dependency on an optional task or to change to OPTIONAL
TASK.
The appropriate configuration of the web request form (9.5.1) provided, OPTIONAL TASKS can be offered
to the user for selection. To do so, make some settings in the tab WEB REQUEST FORM:
- If required, you can enter a differing display text in the template. If this field is empty, the task short
description is shown.
- If additional information is required by the user for the selection of the task, an additional field can be
defined with ADDITIONAL FIELD labeling. If a selection field is concerned, the ADDITIONAL FIELD SELECTION
values can be entered here separated by vertical spacing. If additional options are required for selection,
these selection values will be entered into the accessory selection values field.

= Cancelation conditions in Change Templates:
The cancelation condition for validation defined under Categories->Validation can be activated there for
individual tasks.

2R

Tasks created on the basis of a task template have a synchronize with template radio button. If this radio
button is activated, changes to the task template will be transferred into the task provided that, when
saving the task template change, the RFC/Change template has been selected for taking over the
Change. In the task overview, tasks for which Synchronize with template has been activated are

identified by the =" icon.

=  Program execution
Store an (automatic) program execution for each single task.
Use cases:

o Deactivate process editor
Send mail automatically
Execute Powershell script
Link Cls subsequently
Start ClI Import

O O O O

Some automatisms are pre-defined under execution control. These execution controls are examples
that have be customized and adapted to the individual requirements. This checkbox is the interface for
further automatisms that can be created individually, if required.

As for EXECUTION TIME, enter the period of time available for the background process because the
execution might block the client.

LoG PATH allows you to enter a path used for the execution of a command or in an individually created
agent.

As soon as AUTOMATIC EXECUTION has been activated, the task will be identified in the workflow overview
by the *) icon. As regards these tasks, the process editor will only be notified in case of an error. The
execution is triggered periodically in the background until the automatism reports a successful execution
or the end of the calculated task period has been reached (DEADLINE).
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Click eDIT to enter a command and other necessary parameters.
An input window opens where you store execution information for the automatism:

o POWERSHELL EXECUTION: Specify the Powershell-Script to be executed with parameters. You can
enter fields from the change document as variables.

o DEACTIVATE PROCESS EDITOR: In the change document, specify the field name containing the
process editor to be deactivated (e.g. Requesterfullname).

o CMS-IMPORT: requires the ID of the import to be executed and, if applicable, a CI-ID in the
format:
-importname IMPAAUR-A5VGNZ -LinkedCIID <ParentClIDsLinked>

o SIGN DATABASE: Enter the path to the database.

If errors occur during program execution, these will be documented in the PROGRAMM tab of the task.
The task editor will be informed when the execution period of the automatic task has been exceeded or
a critical error occurred. In these cases, manual task editing is necessary to activate the workflow again.

Quick Changes can be used for quickly documenting Changes. Activate the Quick Change option in a
Standard or Emergency template. Quick Change templates may contain only one task.

COC AG HelpMatics™ Page 87 of 121



Administration of HelpMatics™ Change

9.5.3 Task

You can create your own templates in order not to have to record often recurring tasks again and again.
Their use can be restricted to RFCs, Changes or Releases or be made available for all of them.

For the process editor also the placeholders <ChangeManager>, <Sponsor>, <Requester> or
<Executor> can be selected. Only valid HelpMatics™ process editors and process teams, however, will
be replaced.

The <supervisor> placeholder will be set when a web-task editor (PROCESS EDITOR (MANUAL, WEB-TASK))
is assigned: here you can choose between manual input and supervisor. <Supervisor> will be replaced
with the supervisor selected in the web request (note: should be defined as mandatory field in the web
request form if the placeholder is used in the connected change template).

With rights restricted activated, the task can only be edited if

- the process editor stored for the task is identical with the logged in user
- the logged in user is a member of the process team stored for the task
- the logged in user has change manager rights

Tasks can be marked as optional: When using a Change template with optional tasks, these tasks will be
offered for selection when creating a new task.

As soon as the task template is used in a Change template, this setting can be extended, see chapter
9.5.2.2

The cancelation condition for validation defined under Categories->Validation can be activated there for
individual tasks.

For execution of programs refer to 9.5.2.2

Synchronization of tasks created from task templates.

Changes to task templates will be transferred to existing RFC/Change templates in a controlled way. Is a
task template changed, the user, when saving, will be requested to select those RFC/Change templates,
which the change is to be transferred to.

The selection list contains only RFC/Change templates in which there are tasks that were created on the
basis of the changed task template provided that the Synchronize with template radio button is activated
in the task concerned.
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9.5.4 Service level

(Also see 7.3.1)

Target working hours and service times (both under the SERVICE TIMES tab) in the service level templates
are relevant to the Change module. They are used for calculating end date and process times.

::Eimse | S EED
NN

~, . .
Service Level for clients

Definition ] Service times ] Pracess time ] tlonitoring ] Hierarchical escalation]

oz O

Daylight savings time: © On & Off

tonday Tuesday Wednesday Thursday Friday Saturday Sunday

[08:00 - 17:00 ® [08:00- 17:00 @] [08:00- 17:00 @] [08:00 - 17:00 ®| [08:00-17:00 @] [08:00- 17.00 @] [08:00 - 17:00 @]

The service hours are used for calculsting the process time of the service desk.

Target working hours: "800,

(per day)
Relevart for timing in HelpMatics Change.

Fig. 47: Service level (service times and target working hours)

955 Print

Print templates are available if configured accordingly under Modules->Integration. For details, refer to the
HelpMatics™ Admin documentation.

The following print templates are available for selection: Web request, RFC, Change and Task.

RFC and Change print templates may additionally include templates for printing tasks. Via Attach task data
you can specify that the Change or RFC and all tasks relating to it will be printed when such a template is
selected.

You can provide any Word template with book marks whose names are identical with the field names in
HelpMatics™ Change. Insert this template as an attachment in a new print template.

If you press the print button in the RFC or Change document or if you select Print > Document in the Viewer,
you will be requested to select one of the print templates created under Templates > Print.

In the following you will find a selection of field names the contents of which can be transferred into a Word
document by defining a book mark of the same name.

Description Field name
Client name CompanyName
RFC or Change ID ReferenceNumber
Brief description BriefDescription
Description Description

Date of creation CreateDate

Change Manager

Change manager’s e-mail address
Change manager’s phone
Change manager’s cost center
Change manager’s department
Change manager’s location

COC AG

HelpMatics™

CmFullname
CmMailaddress
CmPhone
CmCostCentre
CmbDepartment
CmLocation
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Change manager’'s comment CmComment
Requester RequesterFullname
Sponsor SponsorFullname
Executor ExecutorFullname
Status Status

You can use, among others, the following DocVariable fields in the tasks:

Description DocVariable name
Task editor ProFullName
Brief description BriefDescription
Description Description
Processing Comment
Status Status

9.6 Clients

9.6.1 Archiving

Archiving for closed RFCs/Changes/Releases is configured for each client and with the desired interval. Only
documents that have been closed since the period specified in days will be archived.

::Zi(:lose H Save
NS

Archiving
General data '
Name: " Archiving Std. First archiving: 19.09.2013 16|
Client COC GermanyAG v Period: Every month v
Description: P RFCs /Changes / Releases closedforrOJ days.
4
Archive database: & apps\helpmatics\hm_changeArchiv_d.nsf ;*

* Has to be on the same server as the active database. Specifiy only path and filename.

Server: CN=vsnotes1/0=COC AG

Fig. 48: Archiving settings for closed RFCs/Changes/Releases

9.7 Modules

Here links to other modules are stored. Please note that these settings are server-specific, i.e. this item is to
be edited on each server also in case of cluster operation.

In the Process info tab the notification history upon completion of a Change is displayed.
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Egiclose HSE\NB l:E%Agent:maﬂings

Modules —

Paths ] DB configuration ] Agents ] Integration ] Process info

vail template

[~ RfC/Change completed: Info to Problem ’ E-mail to following recipients __| rJ

v]% Display

E-mail to process owner

E-mail to process editor

™ RfC/Change completed: Info to Incident ’ E-mail to following recipients __| rJ

v]% Display

E-mail to process owner

E-mail to process editor

™ Problem settled: Info to Incident ’ E-mail to following recipients __| rJ

v] % Display
E-mail to process owner

[ L I O A B

Fig. 49: Process information in case of completion

The notification can be made in three levels:
= RFC/Change completed -> Info to Problem
= RFC/Change completed -> Info to Incident
= Problem settled -> Info to Incident

9.8 Reporting

Various statistical analyses are available for RFCs, Changes, Releases and Tasks.
The following views under Reporting — BI-Views shall be used especially for access via ODBC:

a) Changes
Name: (Reporting\BI\Changes)
Alias: vReportChangeBI
Selection: all Changes
Access: [&F_REPORTING] role is necessary
Use: This view can be used for analyzing general Change data.

Corresponding views are available for Releases, RFCs and Tasks.

b) Linked Cls
Name: (Reporting\BIN\linkedCls)
Alias: vReportLinkedClsBI
Selection: all Changes/RFCs that contain links to Cls
Access: [&F_REPORTING] role is necessary
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Use: This view can be used for analyzing links between Changes/RFCs and Cls. For
each entry in the config. items tab a separate entry is maintained within the view.
A link can be established via the Change/RFC ID (Reference).

c) Linked Tickets

Name: (Reporting\BI\linkedTickets)

Alias: vReportLinkedTicketsBI

Selection: all Changes/RFCs that contain links to tickets

Access: [&F _REPORTING] role is necessary

Use: This view can be used for analyzing links between Changes/RFCs and tickets. A

separate entry is maintained within the view for each entry in the Tickets tab. A
link can be established via the Change/RFC ID (Reference).

d) Linked RFCs/Changes

Name: (Reporting\BI\linkedRFCsChanges)

Alias: vReportLinkedRfCsChangesBI

Selection: all Releases that contain links to RFCs/Changes

Access: [&F REPORTING] role is necessary

Use: This view can be used for analyzing links between Releases and Changes/RFCs.

A separate entry is maintained within the view for each entry in the
RFCs/Changes tab. A link to further Release data in the (Reporting/Bl/Releases)
view can be established via the Release ID (Reference).
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10 Interfaces

10.1 Web service for creation and update of Incident tickets

Incident tickets can be created and updated automatically by calling a web service. This also allows you to
obtain ticket data on the basis of the ticket ID. The web service integrated in HelpMatics™ provides three
functions: CREATEINCIDENT, GETINCIDENTDATA, UPDATEINCIDENT.

Tickets with status SCHEDULED can neither be created using the Web service nor updated.

The web service is located in the HelpMatics™ portal database.
The WSDL file is called via the following link:

http://<ServerName>/<Path>/<PortalDatabase>.nsf/IncidentHandler?wsdlI

<ServerName> Server name
<Path> Path to the HelpMatics™ portal database
<PortalDatabase> File name of the portal database

10.1.1 Getting data on individual Incident tickets
When you enter a valid ticket ID, the GETINCIDENTDATA function will return the following values of a ticket:

Ticket ID Subcategory 1 Priority

User ID Subcategory 2 Name of the responsible person/team
ClID Type Process editor's name

Brief description Root cause Request

Main category Status Solution

<scapenv:Envelope xmlns:soapenv="http:f/sc_:_; = <soapenv:Envelope xmlns:scapenv="http://schemas.xulsoap. org/soap/envelope/" mlns:xsd="http:/ wn
“<goapenv: Header /= = <soapenv: Body=
<soapenv:Body> = =ns0: GETINCIDENTDATAReturn xulns:ns0="urn:lefaultNamnespace">
“urmn: ID>CAT—llDQDQDSSSSZ—PHuIQ’urn: I i3 <STATUS=0</STATUS>
< fsoapenv:Body: =ETATUS_TEHT/*
</soapenv: Envelopes <INC»

=ID=CAT-11030908225Z-PHu</IDx>
<USER_IDrtailor-wa</USER_ID>
<CI_IDs=
“BRIEFDESCRIPTION=PDF Dateien kinnen nicht mehr gedffnet werden</ERIEFDESCRIPTION=
“MATNCATEGORY=Client Application</MAINCATEGORY=
=SUBCATEGORY1l-Acrobat Reader</SUBCATEGORY1=
=BUBCATEGORYE /=
=INCIDENT_TYPErIncident 3 - Lésung Znd-Lewvel-</INCIDENT_ TYPE>
=INCIDENT_ROOTCAUSE=Failure</INCIDENT ROOTCATSE-
“3TATUE_MO=1</3TATTS_NO=
=PRIORITY NO=Z</PRIORITY NO=
<INCIDENT_OWHER-Huber Meier , DPeter Alexander</INCIDENT_OWHEL:-
=INCIDENT_EDITOR=Huber Meier , Peter Alexander</INCIDENT_EDITOR:
=REQUEST*02.0%. 2011 08:33 (GMT + 1) won Peter Alexander Huber Meier:
IDF Dokumente kinnen nicht mehyr gedffnet werden, keine Fehlermelduny, Adobobe Acrobat dffrnet mit
“EZ0LUTIONS =
=¢IHNC=
</ns0: CETINCIDENTDATADSt urns
</soapenv:Bodys

</soapenv: Envelopesr

Fig. 50: Example of GETINCIDENTDATA

For status and priority, numerical values will be returned. For help concerning assignments, refer to the
tables below or the service level document (HelpMatics™ Administration, Templates -> ServiceLevel).
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Priority Icon Meaning Numerical value
Priority 1 & Suggestion: asap 5

Priority 2 + Suggestion: very high 4

Priority 3 -+ Suggestion: high 3

Priority 4 Y Suggestion: Standard 2

Priority 5 + Suggestion: low 1

The priorities are defined in the client’s service level document.

Status Icon Numerical value
closed & 5
work in progress @ 2
open & 1
on hold & 4
external & 3

10.1.2 Creating Incident tickets

Incidents are created by using the CREATEINCIDENT function.

The incident will only be created successfully if valid data has been entered and all mandatory fields have

been filled.
UserlID / CIID:

- Valid userID (especially for users) or CIID (for all other CI types)
- UserID or CIID is a mandatory field

Brief description:
- Mandatory field
Category:

- Valid category incl. valid subcategories

- Mandatory field

Type: <INCIDENT_TYPE>:

- Valid type
- Mandatory field

Root cause: <INCIDENT_ROOTCAUSE>:

- Valid root cause
- Mandatory field

Status: <STATUS_NO>:

- No mandatory field; if status field is empty, Open will be used as default status value
- If status is used, it will be displayed as a numerical value (see table in chapter 10.1.1)

COC AG
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Priority: <PRIORITY_NO>:

aki<s

- No mandatory field; if priority field is empty, the default priority will be used. This priority can be
overwritten by a priority specified for a user.

- If priority is used, it will be displayed as a numerical value ( see table in chapter 10.1.1)
Responsible person/team: <INCIDENT_OWNER>:
- Mandatory field in the form of last name, first name

Editor: <INCIDENT_EDITOR>:

- Mandatory field in the form of last name, first name

HELPMATICS™ CMS ENTERPRISE:
Service <SERVICE_CIID>:
- CIID of a service

Notification sent to the user during ticket creation <SENDINFOMAILTOUSER>:

Basically, the settings for sending mails to users are mandatory in the client document. User notification can
be activated or deactivated here. If a ticket is created with status CLOSED, the final mail message will be sent.

Transfer value “1” -> Send e-mail to user

Transfer value “0“ -> Do not send e-mail to user

“soapenv:Header />

“zoapenv:Bodys
“urn:USER ID=agmell-sa</ urn:USER_ID=
<urn:0I_ID></urn: CI_ID>
“urn:BRIEFDESCRIPTION:=Neuen User anlegen</urn:BRIEFD
“urn: BEQUEST==/urn: REQUEST=
“urn: S0LUTION=</urn: SOLUTION:
“urn:MATHCATEGORY=SAP< urn: MATNCATEGORT -
“urn: STBCATEGORY1=Basic</urn: SUBCATEGORY 1=
“urn: SUBCATEGORYZ=</urn: SUBCATEGORTZ =
“urn: INCIDENT TYPE=Incident</urn: INCIDENT TYPE=
“urn: INCIDENT ROOTCAUSE-Serwice</urn: INCIDENT ROOTCA]
“urn: STATUE _NO=</urn: STATUS_NO=
“urn:PRIORITY NO=</urn: PRIORITY_ NO=
“urn: INCIDENT OWNER=Ballauf, Christoph</urn:INCIDENT
“urn: INCIDENT _EDITOR-Ballauf , Christoph</urn:INCIDE

< /soapenv:Body>

“fsoapenv: Envelopes

Fig. 51: Example of CREATEINCIDENT

10.1.3 Updating Incident tickets

<soapenv: Envelope xmlns:sospenv="http://schenas. xmlsoap.or|*|

Ry | XML

“soapenv:Envelope xmlns:soapenv="http://schemas. xmlsoap.orgfsoap/envelope/s
“zoapenv:Bodys
“ns0: CREATEINCIDENTReturn xmlns:ns0="urn:DefaultNamespace":

=3TATUS=0</STATUS=

=ETATUS_TEXT/ >

=INC=
=ID=CCH-1103159160919-001</I0>
<UZER_IDragnell-sa</USER ID>
<CI_ID/*
“BRIEFDESCRIPTION=Neuen User anlegen</BRIEFDESCRIPTION:-
“MATHNCATEGORY=SAP-</MATNCATECGORTY =
=EUBCATEGORY1=Basic«/SUBCATEGORY1=
=SUBCATEGORYZ /=
<INCIDENT TYPE=Incident</INCIDENT TYPE=
=INCIDENT_ROOTCAUSE=Service</INCIDENT ROOTCAUSE=
“ETATUS_NO=1</STATUZ_NO=
“PRIORITY MNO=4</PRIORITY NO=
=INCIDENT_OWNER-Ballauf, Christoph</INCIDENT_ OWHER=
<INCIDENT_EDITOR=Eallauf , Christoph-</INCIDENT_EDITOR=
<REQUEST /=
“S0LUTION/ =

=/INC=

=/ns0: CREATEINCIDENT Returns=
=/ soapenv:Body:

</soapenv: Envelopes

Tickets are updated by using the UPDATEINCIDENT function. A valid ticket ID with <ID> parameter must be

entered.
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Only filled parameters will overwrite values in the ticket. Empty values will not cause any changes. Therefore,
fields of an Incident ticket cannot be emptied. Please take care here as well that valid values are entered
(see description on how to create tickets).

Incident tickets with Closed status cannot be updated.

<soapenv: Envelope xmlns:soapenv='"http://schenas xmlsoap. org/soap/sy=| : g <zoapeny: Envelope xmlns:soapenv="http://schenss. rmlsoap org/sosp/envelope/"

“soapenv:Header/= = “soapenv: Bodys
“soapenv:Body> % “pns0:UPDATEINCIDENTResturn xnlns:ns0="urn:DefaultNanespacs ">

<urn: ID-CCH-110213160313-001</ arn: ID> =2 <BTATUS=0=/3TATUS>

“arn:UEER_ID-< urn:TSER_ID= <ETATUS_TEHT/*

<urn:CI_ID»</surn:CI_ID»> <INC»

“urn:BRIEFDESCRIPTION=Neus User anlegen</urn:BRIEFDESCRIDPTIOR “ID=CCH-110212160919-001</TI0>

<urn: REQUEST=</urn: REQUEST= <USER_IDramell-sa</USER_ID>

“urn: SOLUTION=< urn: SOLUTION> “CI_ID/*

“urn:MAINCATEGODRY>< furn: MATNCATECGORY > “BRIEFDESCRIPTION=>Neus User anlegen</ERIEFDESCRIPTION:

<urn: SUBCATEGORY1l=</urn: SUBCATEGORY 1= <MATNCATEGORT=SAP~/MATNCATEGORT=

<urn: SUBCATEGORYE>< furn: SUBCATECORYZ> <EUBCATEGORY1>Basic< /EUBCATECORY1>

<urn: INCIDENT_TYPE»<surn: INCIDENT_TYPE= <SUBCATEGORYZ =

“urn: INCIDENT _ROOTCAUSE=</urn: INCIDENT _ROOTCAUSE- <INCIDENT_TYPE=Incident</INCIDENT TYPE=-

<urn: STATOS_NO=</urn:STATUS_NO= <INCIDENT_ROOTCAUSE>Service</INCIDENT_ ROOTCAUSE:=

“urn: PRIORITY NO=3</urn: PRIORITY NO= “STATUS _NO=1=/STATUS NO=

“urn: INCIDENT_OWNER: </ urn: INCIDENT_OWNER: <PRIORITY NO=-3</PRIORTITY MO

<urn: INCIDENT_ELITOR=</urn: INCIDENT_EDITOR= <INCIDENT_OWMER=Eallauf, Christoph</INCIDENT_OWHNER=
“fsoapenv:Body> <INCIDENT_EDITOR:Ballauf , Christoph+/INCIDENT_EDITOR:

=/soapenv: Envelopes =REQUEST/*
“E0LUTION/ =
</INC*
=/ns0: UPDATEINCIDENTReturns
<fsoapenv: Body:
</soapenv: Envelppe>

Fig. 52: Example of UPDATEINCIDENT

10.1.4 Status updates returned by the web service

The web service does not only return the created/changed document but also status updates.

<STATUS> and <STATUS_TEXT> indicate if the process has been completed successfully.

<STATUS> yields a numerical value. If the value is > 0, an error occurred and <STATUS_TEXT> shows the
corresponding message.

10.2 Web service for creating a Change

Change tickets can be created and updated automatically by calling a web service. This also allows you to
retrieve the current status on the basis of the Change ID. The web service integrated in HelpMatics ™
provides the following functions:

GETTEMPLATES Retrieves a list of standard Change templates released for web
service.

GETOPTIONALTASKS Retrieves a list of optional tasks concerning a standard Change
template.

CREATECHANGE Creates of a Change specifying a template
Template data can be overwritten by transferring parameters.
Selected optional tasks can be added.

GETSTATUS Queries the Change status

The web service is located in the HelpMatics™ portal database.
You'll get to the download of the WSDL file via the following link:
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http://<ServerName>/<Path>/<PortalDatabase>.nsf/ChangeHandler
The WSDL file can be displayed directly via the following link:
http://<ServerName>/<Path>/<PortalDatabase>.nsf/ChangeHandler?wsdl

<ServerName> Server name
<Path> Path to the HelpMatics™ portal database
<PortalDatabase> File name of the portal database

10.2.1 Retrieving a list of available Change templates

Via the GETTEMPLATES function a list of available standard Change templates with the following attributes
is retrieved:
Name
Main category
Subcategory 1
Subcategory 2
Brief description
When calling the list, you can define main category, subcategories 1 and 2 as filter criteria.
Example:
<soapenv:Envelope xmins:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmIns:urn="urn:DefaultNamespace">
<soapenv:Header/>
<soapenv:Body>
<urn:MAINCAT>Hardware</urn:MAINCAT>
<urn:SUBCAT1></urn:SUBCAT1>
<urn:SUBCAT2></urn:SUBCAT2>
</soapenv:Body>
</soapenv:Envelope>

If no released template that matches the filter criteria is found, no templates available will be returned as
status text.

10.2.2 Retrieving a list of available optional tasks

To obtain a list of available optional tasks, call the GETOPTIONALTASKS function with a valid template
name.

The list of optional tasks contains task ID and brief description. If an invalid template name was entered,
status 5001 with status text Could not find template is returned.

10.2.3 Creating Change tickets

Standard Changes are created by using the CREATECHANGE function.
A Change can only be created successfully if valid data has been entered.
Mandatory entry:

TEMPLATE_NAME Name of a standard Change template that has been released for webs
service (Availability in module).

Other mandatory fields (see HelpMatics™ Change user manual) are either covered by the template or must
be transferred as parameters.
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Optional data (allows values of the template to be overwritten):

CM_FULLNAME

CM_MAIL

REQUESTER_FULLNAME
REQUESTER _MAIL

EXECUTOR_FULLNAME
EXECUTOR_MAIL
SPONSOR_FULLNAME
SPONSOR_MAIL

CARRIERTICKETOWNER_

FULLNAME
MAINCATEGORY
SUBCATEGORY1
SUBCATEGORY2
CHANGE_TYPE
CHANGE_PRIORITY
CHANGE_URGENCY
CHANGE_IMPACT

CHANGE_
BUSINESSRELEVANCE

CHANGE_RISKLEVEL
DOCLINKSERVER
DOCLINKDBPATH
DOCLINKUNID
BRIEFDESCRIPTION
DESCRIPTION
FIELDVALUEPAIRS

COC AG

Name of the Change Manager in the format <last name> , <first
name>or [<process team>]

If the value corresponds to a process editor, settings from the
process editor document will additionally be transferred.

Change Manager's e-mail address

If this address is clearly assigned to a user (Cl), fields of the User ClI
will additionally be transferred (_Mail has priority over _Fullname as
key).

If only _Mail and no _Full name is transferred, the contact person
must be identifiable in the CMS; otherwise the creation of a Change
will be refused.

Requester's name (also see CM_FULLNAME)

Requester's e-mail address (also see CM_ MAIL)
A link to the identifiable user CI will be created.

Executor's name (also see CM_FULLNAME)
Executor's e-mail address (also see CM_ MAIL)
Sponsor's name (also see CM_FULLNAME)
Sponsor's e-mail address (also see CM_ MAIL)

Name of the person/team responsible for the carrier ticket

Valid main category
Valid subcategory 1
Valid subcategory 2
Valid type

Priority

Urgency

Impact

Business relevance

Risk

Notes document to be linked: Server name
Notes document to be linked: Database path
Notes document to be linked: Universal ID
Brief description

Description

Any field name-field content pairs in the format #field namel#field
contentl#~#field name2#field content2#...

HelpMatics™
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OPTTASKS Task IDs of the optional tasks to be added, separated by @ (if the
Change template used only contains optional tasks, at least one task
ID must be entered).

10.2.4 Retrieving the status of a Change ticket

If a valid ticket ID is transferred, the GETSTATUS function will return the current status of the Change ticket.
The value returned is a status number:

Status Status number

Draft

new

processing: active

processing completed

reviewed

N | AW |IN|[FPL]|O

processing: on hold
closed 20

canceled/rejected 22

If the Change cannot be found, -9000 will be returned.
In case of an error, the error code with description will be returned.

10.3 Web service for access to Cl data

Cl data can be retrieved via web service. You'll get to the download of the WSDL file via the following link:
http://<ServerName>/<Path>/<PortalDatabase>.nsf/CmsHandler

The WSDL file can be displayed directly via the following link:
http://<ServerName>/<Path>/<PortalDatabase>.nsf/CmsHandler?wsdl

<ServerName> Server name
<Path> Path to the HelpMatics™ portal database
<PortalDatabase> File name of the portal database

All Cl data are retrieved via the getAllClIs function. Cls filtered according to type are retrieved via the getCis
function with type (US, HW, ...) being specified.
The functions return the standard ClI data. Field values configured individually are not considered.

10.4 Interfaces for reporting
Besides the reporting options within Notes and the reporting functions of HelpMatics™ there is also the

option to access HelpMatics™ screens and views via the database interface ODBC (Open Database
Connectivity).
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10.4.1 Views

To facilitate access to evaluation relevant data, special views are available that are described in detail in the
Reporting chapter of the individual modules (Name: Reporting\BI\...).

10.4.2 Configuration of ODBC access

In order to have access to Notes databases from other applications (e.g. Excel, Access, Crystal Report), a
NotesSQL driver has to be installed. This driver can be downloaded for free via the HCL download section.

After successful installation of the Notes SQL driver, the NotesSQL Authentication List Manager is to be
called via the Nsgl_ALM.exe file located in the installation directory of NotesSQL. Here, the path to the
Notes.ini configuration file as well as the users accessing Notes are stored.

For ODBC access via NotesSQL, the access control list of the relevant database is considered.
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7 | NotesSQL Authentication List Manager -7 |3

To authenticate Notes users, a NotesSCGL driver uses an ‘authentication list”
maintained on the same computer as the driver. Each entry in the list has a Motes
IUsemame and the location of the Motes 1D file for that Usemame. Only users who
have entries on that list will be authenticated using MotesSGL. This tool allows you
to manage the authentication lists for computers on your network. Tell Me Mare

;

Step 1: Select the computer whose list you want to manage.

To zelect a computer, provide the fullp-gualified path ta the MOTES.IMI file on that
compuker.

Path to HOTES.IMI file on the computer pou wish to manage:

| v Browse...

L

Step 2: Manage the list for the selected computer.

Chooze Digplay list, then add and remove uzers az needed. Save the list when you're
done.

Maotes uger name: Mates |0 path:

Step 3: Repeat.

Repeat steps 1 and 2 for each authentication lizt you want ko manage.

Cloze

FELEE

Fig. 53: NotesSQL Authentication List Manager

Finally, depending on the operating system used (Windows XP, Windows Vista ...) a connection (Notes
ODBC Connect) to the desired Notes database is to be established via the ODBC data source administrator
and/or the application used. For detailed instructions refer to the help of the respective application.

10.4.3 Configuration for Crystal Reports

Some predefined reports in Crystal Reports format are included in delivery. To run these reports, use e.g.
Saberlogic Logicity products (http://www.logicitysuite.com).

Configuration:

1. You require NotesSQL (installation see chapt. 10.4.2) and ODBC data sources for the Notes
databases with the following names:
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hm_servicedesk

hm_admin

hm_change

hm_survey

and, in addition, if HelpMatics™ CMS is used: hm_cmsep for access to the SQL-based CMS
database.

2. Start the Logicity for Crystal Reports download via the following link:
http://www.logicitysuite.com/support/downloads.html
3. Install Logicity for Crystal Reports.

4, After the installation, start Logicity Desktop. Select the path to the storage location of the desired
report and open the report. Enter parameters for the report.
Use the Logicity Solution Builder to save reports according to schedule, print them or send them by
e-mail.

Report parameters:
- Evaluation month in yyyy-mm format, empty parameter corresponds to the previous month

- Client: Naming of client as configured in HelpMatics™ Administration; when the parameter is empty, all
clients will be included in the report.

- Responsible person’s department: when the department is specified, only tickets will be considered
where the specified department corresponds to the department of the currently responsible person.

- Show availability report: Determine if the availability resulting from the ACD data is to be specified in the
report.

- Path to the logo: The HelpMatics™ logo is used by default. Enter the path to a different loge/graphics
here. .jpg format is required, a width/height of 450 px or 12 cm must not be exceeded.

Please note:

Use a blank to specify empty parameters in the LOGICITY configuration.
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11 Background processes supporting the configuration

11.1 Automatic configuration check

An automatism running periodically (by default 1 * at night) checks the configurations referred to hereinafter,
transfers changes in some cases directly or identifies templates invalid due to configuration changes.

11.1.1 Changes to process teams

If team members or e-mail addresses change in a process team available for the SERVICEDESK module, this
change will be transferred to tickets that have not been closed by the periodically running background
process.

If team members or e-mail addresses change in a process team available for the CHANGE module, the user
can decide if the changes are to be immediately transferred to RFCs, changes, releases, tasks and
templates or if this update is to be made by the background process.

Team members or e-mail addresses are updated in:

- Task templates,

- Tasks in RFC or change templates (current process team),

- Tasks in RFCs, changes, releases when the task has not been completed ,

- RFCs, changes, releases: Contacts (change manager, sponsor, executor, requester) — if a process team
is concerned — when process editing has not been completed.

11.1.2 Templates

Ticket templates are checked for:

- Valid categories when HelpMatics™ CMS Enterprise is used in connection with the related service,
- Valid types and root causes,

- Module availability of the process editor and/or process team,

- If a portal ticket template is concerned, module availability of the responsible person will be checked.

Change/RFC/release templates are checked for:

- Valid categories if HelpMatics™ CMS Enterprise is used in connection with the service assigned,
- Valid type,
- Availability of the process teams involved under contacts in the RESPONSIBILTY tab.

Invalid templates are identified by color and are no longer available for ticket creation. In addition, you can
find those under ADMINISTRATION — MAINTENANCE — INVALID TEMPLATES. To identify which data are incorrect
refer to the INVALID DATA tab in the template document. When HelpMatics™ is started, HelpMatics™
Administrators will receive a warning that templates with invalid data exist.
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11.2 Automatic synchronization of process editors/teams with Domino Directory or
Active Directory

Process editors and process teams can be synchronized with the Domino Directory or the Active Directory
automatically. For this purpose, two agents have been designed for the HelpMatics™ Admin database which
have to be customized to the respective environment.

For this, the agent in the MyConstants.java space has to be edited.
Here, the default values

- client

- module release

- Mail info yes/no, Mail templates and Link type in mails
- calendar system and mail system

are determined.

Furthermore, specific data for the import from Domino or Active Directory are stored.

Synchronization with Active Directory

- agroup in the Active Directory must contain a specific OU, e.g. OU=HelpMatics
- OuU filtering can be made via the GROUP_DN_FILTER constant in the synchronization agent.
- So, the group and all members of this group will be created as process editors

Synchronization with Domino Directory

- Agroup in the Domino Directory must be assigned to a specific category, e.g. HelpMatics

- The name of this category will be stored in the configuration in the synchronization agent
(GROUP_CATEGORY)

- So, the group and all members of this group will be created as process editors

Generally applicable:

- When a team exists already, new team members will be created as process editors with identical
settings (client, module, mail info, etc.).
- Manual changes to default values of process editors/teams made subsequently will not be overwritten

Process editors that have been created automatically and are not a member of any HM team any longer will
be removed automatically.
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12 Field descriptions

12.1 Incident & Problem

If you are using HelpMatics™ CMS, additional fields identified by (CMS) in the list are available.

Field name
General
ReferenceNumber

MainCategory
SubCategoryl
SubCategory?2
ToDo
RootCause
ProblemShort
Problem
Solution
Process
Screenshot
Enclosure
CreateDate
DateClosed
DateD

DateT
DateWZone
ProcessTime
Counter
Service (CMS)
FirstLAName

User
FirstName
LastName
UserlD
User_CIID (CMS)
Position
OfficePhoneNumber
MobilNumber
MailAddress
FaxNumber
EmployeelD
CostCentre
RoomNr
Location
Building
Department

COC AG

Field type Description

Text Client abbreviation + unique number + process editor
abbreviation

Text Main category

Text Subcategory 1

Text Subcategory 2

Text Type

Text Root cause

Text Brief description

Text Request

Text Solution

Text Processing

Rich text Field for screenshots

Rich text Field for attachments

Date/Time Create time and date

Date/Time "Status closed" date

Date - Date  Date - date only

Date - Time Date - time only (without time zone)

Date/Time Date - date and time (incl. time zone)

Number Process time in minutes (calculation only after completion)

Number Forward count

Text Service ClI

Text Name of service level template

Text First name

Text Last name

Text User ID

Text unique user ID in HelpMatics™ CMS

Text User's position in the company

Text Phone number (office)

Text User's mobile phone number

Text User's mail address

Text Fax number

Text User's employee ID

Text Cost center assigned to the user

Text Room where you'll find the user

Text Location

Text Building

Text Department where the user works

HelpMatics™
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BusinessUnit Text
CompanyName Text
CompanyShort Text
VIP Text
Caller

Caller_FirstName Text
Caller_LastName Text
Caller_UserlD Text
Caller_CIIDUS Text
(CMS)

Caller_Position Text

Caller_OfficePhone  Text
Number

Caller_MailAddress  Text
Caller_Department  Text

User's configuration items

User_EquipNumber  Text
User_CIIDHW

(CMS)

User_EquipCategor Text
y

User_EquipManu Text
User_EquipModel Text
User_EquipType Text
User_EquiplPAddre  Text
SS

User_EquipOSVersi Text
on

Cl (root cause) - Hardware

EquipNumber Text
CIIDHW (CMS) Text
EquipCategory Text
EquipManu Text
EquipModel Text
EquipType Text
EquipDescription Text
EquiplPAddress Text
EquipOSVersion Text
EquipLocation Text
EquipBuilding Text
EquipRoomNr Text

Cl (root cause) - software (CMS)

SW_Label Text

COC AG

Name of the organization
User's client

Client abbreviation
Specified priority

Caller's first name

Caller's last name

Caller's user ID

unique user ID in HelpMatics™ CMS

Caller's position in the company
Caller's (office) phone number

Caller's mail address
Department where the caller works

Config. item number
unique config. item ID in HelpMatics™ CMS

Config. item category

Config. item manufacturer
Config. item model
Config. item type

Config. item IP address

Config. item software version

ClI (root cause) number

unique CI ID in HelpMatics™ CMS
ClI (root cause) category

ClI (root cause) manufacturer

Cl (root cause) model

Cl (root cause) type

Cl (root cause) description

Cl (root cause) IP address

ClI (root cause) software version
Cl (root cause) location

Cl (root cause) building

Cl (root cause) room

Cl (root cause) name
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ClIIDSW
SW_Category
SW_ Manufacturer
SW_Model
SW_BuildType
SW_Version
SW_Language
SW_LicenceNo

Text
Text
Text
Text
Text
Text
Text
Text

Cl (root cause) - service (CMS)

SC_Label

ClIbsC
SC_Category
SC_Responsible
SC_Impact
SC_BuildType
SC_ValidFromDate
SC_ValidTillDate
SC_LAName

Editing status
Status

StatNr
StatusHistory
StatusHistoryD

StatusHistoryU
Priority

PrioNr
PriorityHistory
PriorityHistoryD

PriorityHistoryU
FeedbackWay
DeadLine
DEADLINE2ND

Responsibility
RespFullName
RespPhoneNumber

RespCompanyNam
e

RespDepartment
RespComShort
RespMail

COC AG

Text
Text
Text
Text
Text
Text
Text
Text
Text

Text

Number
Text list
Date/time
list

Test list
Text
Number
Test list
Date/time
list

Text list
Text
Date/Time
Date/Time

Text
Text
Text

Text
Text
Text

unique CI ID in HelpMatics™ CMS
Cl (root cause) category

ClI (root cause) manufacturer

ClI (root cause) license name

Cl (root cause) type

ClI (root cause) version

ClI (root cause) language

Cl (root cause) license number

Cl (root cause) name

unique CI ID in HelpMatics™ CMS

ClI (root cause) category

Person/team responsible for the CI (root cause)
Cl (root cause) impact factor

Cl (root cause) type

ClI (root cause) valid from

Cl (root cause) valid until

Cl (root cause) name of service level template

Status ("open", "work in progress", "assigned external”, "on
hold", "closed")

Status number (1, 2, 3, 4, 5)

History of status changes of an Incident ticket

History of times of status changes

History of persons that changed the status

Priority

Priority number from 1 (lowest) to 5 (highest priority)
History of priority changes of an Incident ticket
History of times of priority changes

History of persons that changed the priority
Type of date, e.g. reminder
Calculated process deadline (client monitoring)

Calculated process deadline for the current group (process
editor monitoring)

Person/team responsible until the task is closing
Creator's phone No.
Creator's client

Department
Creator's client abbreviation
Creator's e-mail address
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Rname

Process editor
ProFullName

ProPhoneNumber
ProDate

ProCompanyName
ProComShort
ProDepartment
ProMail
ProNameTime
ProTime
GroupMembers
Uname

ptDate, ptTime,
ptUser
Process teams

ProGrpName
ProGrpStart

ProGrpEnd

ProGrpEscLevel

System fields
HMID
IcoBackInfo
IcoFeedBackWay
IcoPrioNr
IcoStatNr
KnowledgeBase
Server
SortStatNr_RefNr
ALERTDATELST

ALERTTEXT1ST
ALERTDATE2ND

ALERTTEXT2ND
Readerl
Reader2
Reader3

Author
LASTEDITEDAT
LASTEDITEDBY

COC AG

Text

Text list

Text list
Date/time
list

Text list
Text

Text list
Text list
Text list
Number list
Test list
Text

Text list

Text list
Date/time
list
Date/time
list

Text list

Text
Number
Number
Number
Number
Text

Test list
Text
Date/time
list

Test list
Date/time
list

Test list
Reader
Reader
Reader
Text
Date/Time
Text

Responsible person's first and last name (common name)

Processor list; the last process editor in this list is process
owner

Process editor phone No. list
Date of assignment list

Process editors' client list

Client abbreviation of the current process editor
Process editors' department list

E-mail address of the current process editor

History of manually entered process times incl. names
History of manually entered process times

Team members if ticket is forwarded to a process team

First and last name of the current process editor (common
name); is empty if a process team is concerned

List of associated data: Date stamp of time recording, time
recorded per day, user name

List of process teams involved
Date of assignment to process team

Date of process end of a team

Escalation level reached (process editor monitoring)

internal HelpMatics™ ID (for Enterprise setup)
Icon value

Icon value

Icon value

Icon value

Transfer to knowledge database

Information on server and database

Sort field

Monitoring levels (client monitoring)

Monitoring descriptions (client monitoring)
Monitoring levels (process editor monitoring)

Monitoring descriptions (process editor monitoring)
Read access to ticket

Read access to ticket

Read access to ticket

Access rights to Author access level

Ticket was last changed on/at

Ticket was last changed by
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CallOpen
bulkTicket
FeedBackPro
Form

12.2 User (CMDB)

Text
Text
Text
Text

Holp-MAaki<s

Reopen performed? Y/N

Master tickets/sub-ticket ID (1=master ticket, 2=sub-ticket)
Status of return

Screen name

When using HelpMatics™ CMS, refer to the HelpMatics CMS Enterprise documentation, chap. 3.4.2 column
definitions, for field names.

Field name Field type Description

Building
BusinessUnit
CompanyName
CompanyShort
CostCentre
Department
EmployeelD
FaxNumber
FirstName
FlexField1
Floor
LastName
Location
MailAddress
MobilNumber
OfficePhoneNumber
Position

PrioNr

Priority
RoomNr

Title

UserlD

VIP

System fields

Readerl, reader2
Author

COC AG

Text
Text
Text
Text
Text
Text
Text
Text
Text
Text
Text
Text
Text
Text
Text
Text
Text
Number
Text
Text
Text
Text
Text

Reader
Text

Building

Business unit

User's client

User's client abbreviation

Cost center the user is assigned to
Department where the user works
User's employee ID

User's fax No.

First name

Flexibly usable field

Floor

Last name

Location

User's mail address

User's mobile phone number
Phone number (office)

User's position in the company
Priority No. in case of specified priority
Priority description in case of specified priority
Room where you'll find the user
Title

User ID

Specified priority ("1" = activated)

Read access to document
Access rights to Author access level
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When using HelpMatics™ CMS, refer to the HelpMatics CMS Enterprise documentation, chap. 3.4.2 column

definitions, for field names.

Field name Field type
EquipAccout Number
EquipContractPeriod Text
EquipDeliveryDate Date/Time
EquipFlex_1 Text
EquipFlex_2 Text
EquipFlex_3 Text
EquipLeasRate Number
EquipSerial Text
Building Text
BusinessUnit Text
CompanyName Text
CompanyShort Text
CostCentre Text
Department Text
EquipCategory Text
EquipContractNr Text
EquipDescription Text
EquipHWAddress Text
EquiplPAddress Text
EquipLeasDate_1 Text
EquipLeasDate_2 Text
EquipLocation_1 Text
EquipLocation_2 Text
EquipManu Text
EquipModel Text
EquipNumber Text
EquipOrderNr Text
EquipOSVersion Text
EquipType Text
Floor Text
Location Text
RoomNr Text
additional fields for sub Cls
ParentEquip Text
User fields, see user table
System fields
Readerl, reader2 Reader
Author Text
COC AG

Description

Value

Contract period

Delivery date

Flexible field 1

Flexible field 2

Flexible field 3

Leasing rate

Serial number

Building

Business unit

Cl's client

User's client abbreviation
Cost center the hardware is assigned to
Department the hardware is assigned to
Config. item category

ClI contract number

ClI description

Cl hardware address
Config. item IP address
Cl leasing/purchase start
Cl leasing/purchase end
Cl location 1

Cl location 2

Config. item manufacturer
Config. item model
Config. item number

Cl order number

Config. item software version
Config. item type

Floor

Location

Room

Cl number of the parent ClI

Read access to document

Access rights to Author access level
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12.4 Web request

Field name
Requester
Lastname
Firstname
Email
Phone
Department
Location
Costcentre
Facsimile

Reporter
Lastname2
Firstname2
Email2
Phone2
Department2
Location2
Costcentre2
Facsimile2

Supervisor
svLastname
svFirstname
svMailaddress
svPhone

Change Manager
CmFullname
CmPhone
CmMailaddress
CmDepartment
CmLocation
CmCostcentre
CmCompanyName
CmCompanyShort

General
Description
Reason
Target
Suggestion
Improvement
Cimpl

COC AG

Field type

Text
Text
Text list
Text
Text
Text
Text
Text

Text
Text
Text list
Text
Text
Text
Text
Text

Text
Text
Text
Text

Text
Text
Text list
Text
Text
Text
Text
Text

Text
Text
Text
Text
Text
Date/Time

Description

Requester's last name
Requester's first name

Holr-Makizs

Requester's e-mail address

Requester's phone

Requester's department

Requester's location

Requester's cost center

Requester's fax

Reporter’s last name

Reporter’s first name

Reporter’s e-mail address

Reporter’s phone

Reporter’s department

Reporter’s location

Reporter’s cost center

Reporter’s fax

Supervisor’s last name
Supervisor’s first name

Supervisor’'s e-mail address

Supervisor's phone

Change manager’s name

Change manager’s phone

Change manager's e-mail address
Change manager’s department
Change manager’s location

Change manager’s cost center
Change manager’s client

Change manager’s client abbreviation

Description

Reason

Target

Suggestion
Improvement
Implementation date
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Expense

CATime Text Current expense in hours
CFTime Text Future expense in hours
CAMoney Text Current expense in €
CFMoney Text Future expense in €

System fields

Form Text Screen name

Name Text Name of RFC template

label... Text Field labeling of the filled in Web request template
(Notes client)

value... Text Field labeling of the Web request template (web client)

MailTemplateDemandCancelReq Text Mail template name in case of rejection

MailTemplateDemandinfoCm Text Mail template name in case of info to Change Manager

MailTemplateDemandinfoReq Text Mail template name in case of info to requester

Reader Reader Read access to document

12.5 RFC & Change

Field name Field type  Description

General

ReferenceNumber Text RFC/Change ID

BriefDescription Text Brief description

Description Text Description

CompanyName Text Client

CompanyShort Text Client abbreviation

ImplementationDateEnd Date/Time RFC processing start/Change implementation start

ImplementationDateStart Date/Time RFC processing end/Change implementation end

ChangeRealisationDate Date/Time  RFC implementation date (RFC only)

CreateDate Date/Time  Web request date

Mode Text Type of RFC/Change (standard,normal, emergency)

targetCalculation Text autom. time calculation: fixed end date = "1", fixed task
period = "2"

doRecalc Text automatic calculation ("1" = activated)

Description Text Description

Reason Text Reasons for implementation/non-implementation

Classification

MainCategory Text Main category
SubCategoryl Text Subcategory 1
SubCategoryl Text Subcategory 2
ToDo Text Type

Priority Text Priority
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Urgency
BusinessRelevance
Impact

RiskLevel

Requester
RequesterFullname
RequesterPhone
RequesterMailaddress
RequesterchkinfoMail
RequesterDepartment
RequesterLocation
RequesterCostcentre
RequesterComment
RequesterCompanyShort
RequesterGroupMembers

Caller
CallerFullname
CallerPhone
CallerMailaddress
CallerchkinfoMail
CallerDepartment
CallerLocation
CallerCostcentre
CallerCompanyShort

Supervisor
SupervisorLastname
SupervisorFirstname
SupervisorMailaddress
SupervisorPhone

Sponsor
SponsorFullname
sponsorPhone
sponsorMailaddress
SponsorchkinfoMail
sponsorDepartment
sponsorLocation
sponsorCostcentre
SponsorCompanyShort
SponsorGroupMembers

Executor
ExecutorFullname

COC AG

Text
Text
Text
Text

Text
Text
Text list
Text
Text
Text
Text
Text
Text
Text list

Text
Text
Text-Liste
Text
Text
Text
Text
Text

Text
Text
Text
Text

Text
Text
Text list
Text
Text
Text
Text
Text
Text list

Text

Urgency

Business relevance
Impact

Risk

Requester's name (last name, first name)
Requester's phone

Requester's e-mail address

E-mail notification ("1" = activated)
Requester's department

Requester's location

Requester's cost center

Comment

Requester's client abbreviation

Team members

Caller's name (last name, first name)
Caller’'s phone

Caller's e-mail address

E-mail notification ("1" = activated)
Caller’'s department

Caller’s location

Caller’s cost center

Caller’s client abbreviation

Supervisor’s last name
Supervisor’s first name
Supervisor’'s e-Mail address
Supervisor’s phone

Sponsor's name (last name, first name)
Sponsor's phone

Sponsor's e-mail address

E-mail notification ("1" = activated)
Sponsor's department

Sponsor's location

Sponsor's cost center

Sponsor's client abbreviation

Team members

Executor's name (last name, first name)

HelpMatics™
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ExecutorPhone Text Executor's phone
ExecutorMailaddress Text list Executor's e-mail address
ExecutorchkinfoMail Text E-mail notification ("1" = activated)
ExecutorDepartment Text Executor's department
ExecutorLocation Text Executor's location
ExecutorCostcentre Text Executor's cost center
ExecutorCompanyShort Text Executor's client abbreviation
ExecutorGroupMembers Text list Team members

Change Manager

CmFullname Text Change manager's name (last name, first name)
CmPhone Text Change manager’s phone

CmMailaddress Text list Change manager's e-mail address
CmchkInfoMalil Text E-mail notification ("1" = activated)
CmbDepartment Text Change manager’s department

CmLocation Text Change manager’s location

CmcCostcentre Text Change manager’s cost center
CmCompanyShort Text Change manager’s client abbreviation
CmGroupMembers Text list Team members

Status

Status Text Status (see HelpMatics Change documentation)
StatNr Number Status number

STATSINCE Date/Time  when was the status set

StatEditor Text by whom was the status set

Status-Reporting

dateStatNew Date/Time Time of status "New" set
dateStatProcessingActive Date/Time  Time of status "Processing active" set
dateStatOnHold Date/Time Time of status "On hold" set
dateStatAuthorized Date/Time Time of status "Authorized" set
dateStatClosed Date/Time  Time of status "Closed" set

dateStatProcessingCompleted Date/Time  Time of status "Processing completed" set
dateStatProcessingReviewed  Date/Time Time of status "Reviewed" set
dateStatProcessingRejected Date/Time  Time of status "Rejected" set

Documentation

link Rich text Field for links

Enclosure Rich text Field for attachments

Budget

Effort_1 Number Implementation effort (RFC only)
Duration Number Implementation period (RFC only)
TimeUnit Text Unit for implementation period (RFC only)
EffortETarget Number TARGET external expense

EffortMTarget Number TARGET material expense
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CostsTarget
EffortTActual
EffortMActual
EffortEActual
CostsActual
EffortTDiff

EffortMDiff
EffortEDiff

CostsDiff

Additional information provided by the requester for optional tasks

OptTaskID_<i>
OptTaskLabel_<i>
OptTaskValue_<i>
OptTaskAction_<i>

System fields
targetCalculation
HMID
IcoPrioNr
IcoStatNr
Server
Reader
LeserGeneral
Form

Creator
ReplMark
Autoclose
CarrierlD

12.6 Release

Field name
General
ReferenceNumber
BriefDescription
Description
CompanyName
CompanyShort

ImplementationDateEnd
ImplementationDateStart
ChangeRealisationDate

COC AG

Number
Number
Number
Number
Number
Number

Number

Number

Number

Text
Text
Text
Text

Text
Text
Number
Number
Text list
Reader
Reader
Text
Text
Text
Text
Text

Field type

Text
Text
Text
Text
Text
Date/Time
Date/Time
Date/Time

TARGET costs total

Holpr-Maki<s

ACTUAL expense in hours (Change only)

ACTUAL material expense (Change only)

ACTUAL external expense (Change only)

ACTUAL costs total (Change only)

Difference between total target and actual expense in

h (Change only)

Difference between target and actual material expense

(Change only)

Difference between target and actual external expense

(Change only)

Difference between target and actual costs

ID of the optional task selected in the web request
Opt. task labeling in the web request

Additional input field content in opt. task

Selected auxiliary value in opt. task

automatic time calculation ("1" = activated)
internal HelpMatics™ ID (for Enterprise setup)

Icon value
Icon value

Information on server and database

Read access to document
Read access to document

Screen name

Author of the document

Availability (for Enterprise setup)
ID of standard Changes that are closed automatically
Ticket ID of the carrier ticket

Description

Release ID

Brief description
Description

Client

Client abbreviation
Start date

End date
Implementation date
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CreateDate
targetCalculation

doRecalc

Classification
MainCategory
SubCategoryl
SubCategoryl

Requester
RinitiatorFullname
RinitiatorPhone
RinitiatorMailaddress
RinitiatorDepartment
RinitiatorLocation
RinitiatorCostcentre
RinitiatorCompanyShort
RinitiatorGroupMembers

Executor
RExecutorFullname
RExecutorPhone
RExecutorMailaddress
RExecutorDepartment
RExecutorLocation
RExecutorCostcentre
RExecutorCompanyShort
RExecutorGroupMembers

Release Manager
RManagerFullname
RManagerPhone
RManagerMailaddress
RManagerDepartment
RManagerLocation
RManagerCostcentre
RManagerCompanyShort
RManagerGroupMembers

Status
Status
StatNr
STATSINCE
StatEditor

COC AG

Date/Time
Text

Text

Text
Text
Text

Text
Text
Text list
Text
Text
Text
Text
Text list

Text
Text
Text list
Text
Text
Text
Text
Text list

Text
Text
Text list
Text
Text
Text
Text
Text list

Text
Number
Date/Time
Text

Web request date

autom. time calculation: fixed end date = "1", fixed task
period = "2"
automatic calculation ("1" = activated)

Main category
Subcategory 1
Subcategory 2

Requester's name
Requester's phone
Requester's e-mail address
Requester's department
Requester's location
Requester's cost center
Requester's client abbreviation
Team members

Executor's name

Executor's phone

Executor's e-mail address
Executor's department
Executor's location
Executor's cost center
Executor's client abbreviation
Team members

Release manager’s name

Release manager’s phone

Release manager's e-mail address
Release manager’s department
Release manager’s location

Release manager’s cost center
Release manager’s client abbreviation
Team members

Status (see HelpMatics Change documentation)
Status number

when was the status set

by whom was the status set
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Status-Reporting

dateStatNew Date/Time  Time of status "New" set

dateStatProcessingActive Date/Time  Time of status "Processing active" set for the first time
dateStatOnHold Date/Time  Time of status "On hold" set

dateStatClosed Date/Time  Time of status "Closed" set

dateStatProcessingCompleted Date/Time  Time of status "Processing completed" set

System fields

HMID Text internal HelpMatics™ ID (for Enterprise setup)
IcoPrioNr Number Icon value

IcoStatNr Number Icon value

Server Text list Information on server and database

Reader Reader Read access to ticket

LeserGeneral Reader Read access to ticket

Form Text Screen name

Creator Text Author of the document

ReplMark Text Availability (for Enterprise setup)
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12.7 Task
Field name Field type
General
ReferenceNumber Text
BriefDescription Text
Description Text
TaskType Text
Evaluation Text
Status Text
Comment Comment
Duration Number
TimeUnit Text
Begin_1 Date/Time
Begin_2 Date/Time
Finished_1 Date/Time
Finished_2 Date/Time
Effort 1 Number
Effort_2 Number
Enclosure Rich text
Process editor
ProFullName Text list
ProDate Date list
ProDepartment Text list
ProMailAddress Text list
ProMailLink Text list
ProMailTemplate Text
ProPhoneNumber Text list
ProCompanyName Text list
ProCompanyShort Text
GROUPMEMBERS Text list

IndividualGroupMembers  Text list

Time recording

eDate Date list
Editor Text list
eMin Number list
eHour Number list
eTotalHour Number
eTotalDay Number
History
HistoryAction Text list
HistoryDate Date list
HistoryUser Text list
COC AG

Description

RFC/Change ID of the superior document

Brief description
Description

Type

Evaluation

Status

Editing comment

Min. task period

Unit for min. task period
Start - Target

Start - Actual

End - Target

End - Actual

Expense: Target in hours
Expense: Actual in hours
Field for attachments

List of process editors (last name, first name)

Date of assignment list
Department list of process editors

Mail address(es) of the current process editor/team

Links to be sent

Mail template name

Process editors' phone number list
Process editors' client list

Client abbreviation of the current process editor/team

List of team members for team assignment
Individually compiled list of process editors

Time recording of dates

Process editors' time recording
Time recording in minutes

Time recording in hours

Time recording in hours (total)
Time recording in workdays (total)

History of changes recorded
History of times of changes recorded

History of persons that effected the change
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System fields
HMID
CHBRIEFDESCRIPTION
IcoStatus
Server
Reader
LeserGeneral
Form

Active
PARALLEL
Position
ReplMark

COC AG

Text
Text
Number
Text list
Reader
Reader
Text
Text
Text
Number
Text

internal HelpMatics™ ID (for Enterprise setup)
Brief description of the parent Release/RFC/Change
Icon value

Information on server and database

Read access to document

Read access to document

Screen name

identifies active tasks ("1")

Downgrade in case of parallel tasks

Position in workflow

Availability (for Enterprise setup)
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13 Appendix

HLp-Ii

13.1 Overview of the changed role descriptions

Role description up to V5.5

Role description from V6.0

[ Administration]

[&R_Manager]

[Admin]

[Statistics] [&F _Reporting]
[_Reporting]

[1st-Level] &R_1stLevel]
[2nd-Level] &R_2ndLevel]

[2nd-LevelCreate]

&R_2ndLevelNew]

[_ProblemOwner], [_ProblemEditor]

&R_ProblemOwner], [&R_ProblemEdit]

[_ProblemManager]

&R_ProblemOwner]

Reopen]

&F Reopen]

DelResources]

&F DelResources]

[
[
[
[
[
[
[
[&F_DelTickets]
[
[
[
[
[
[
[

[

[

[DelTickets]

[QuickDelete] &F _QuickDelete]
[ReadAll] &F ReadAll]

[global] &F_Global]
[GlobalAdmin] &F _GlobalAdmin]
[Creator] &R_Creator]

[ Expert] &R_Expert]

[ Manager] &R_KBManager]

[ ChangeManager] [&R_ChangeMngr]

[ DemandCreator] [&R_DEMANDCREATE]
[ TaskEditor] [&R_TaskEditor]

[Poll] [&R_Poll]
[_handleDemand] [&R_DEMANDCREATE]

[_ProfileAdmin]

[&F PROFILE]

COC AG
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14 Imprint

COCAG

Product Management HelpMatics™

Gewerbepark Lindach A 12
84489 Burghausen
Germany

Telephone: +49 (0)8677 / 9747 - 0
fax: +49 (0)8677 / 9747 - 199

E-Mail info@coc-ag.de

Internet: www.helpmatics.com

Please note: HCL Notes/Domino ™ is a protected trademark and enjoys the full protection of legal
regulations applying to registered trademarks.

COC AG takes utmost care that the contents of this manual are correct and topical at the time of their
completion. However, COC AG does not assume any warranty for correctness regarding the contents and
completeness and rules out any liability. COC AG reserves the right to change the contents of this manual or
of parts of it or to supplement it without explicitly indicating it, any time. Use and transmission of information
is made at your own risk.
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